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VPIM Networking

Overview: VPIM Networking
Cisco Unity supports the Voice Profile for Internet Mail (VPIM) protocol, which is an industry standard 
that allows different voice messaging systems to exchange voice, fax, and text messages over the Internet 
or any TCP/IP network. VPIM is based on the Simple Mail Transfer Protocol (SMTP) and the 
Multi-Purpose Internet Mail Extension (MIME) protocol.

For a list of VPIM-compliant voice messaging systems that Cisco Unity supports, see Cisco Unity 
System Requirements, and Supported Hardware and Software, at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html. Note 
that VPIM Networking can be used for messaging between Cisco Unity servers that are in different 
directories, including messaging between Cisco Unity with Microsoft Exchange and Cisco Unity with 
IBM Lotus Domino systems.

VPIM Networking is a licensed feature. If your organization has multiple Cisco Unity servers networked 
together, only one server needs to be licensed and configured for VPIM Networking. The Cisco Unity 
server configured for VPIM Networking is referred to as the bridgehead server. For more information on 
obtaining licenses for Cisco Unity features, see the White Paper: Licensing for Cisco Unity (All 
Versions), at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/products_white_paper09186a008019c743.s
html.

No special permissions are required for VPIM Networking beyond those required for Cisco Unity itself. 
For detailed information about the permissions required by Cisco Unity, refer to Permissions wizard 
Help, which is available in Tools Depot on the Cisco Unity server.

This chapter contains the following sections:

• Setting Up Cisco Unity to Use VPIM Networking, page 7-2—This section describes the 
prerequisites for setting up VPIM Networking, and provides a task list containing a high-level view 
of all of the tasks you need to complete for the setup, and the order in which they should be 
completed.

• Procedures for Setting Up Cisco Unity to Use VPIM Networking, page 7-3—This section contains 
all of the step-by-step procedures necessary to set up Cisco Unity for VPIM Networking.

• VPIM Concepts and Definitions, page 7-21—This section explains VPIM Networking concepts in 
detail. If you are unfamiliar with VPIM Networking, read this section prior to doing the setup 
procedures.

• VPIM Reference, page 7-34—This section contains tables that define the fields on the Cisco Unity 
Administrator web pages related to VPIM setup, and briefly explain the options for correctly 
entering information in the fields.
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• Maintenance, page 7-38—This section provides information about monitoring system activity.

• Notable Behavior, page 7-42—This section documents notable behavior related to VPIM 
Networking.

Related Documentation

• “Using VPIM for Networking with Cisco Unity Express or Other Cisco Unity Systems”

• Troubleshooting VPIM Transport, at http://www.ciscounitytools.com/Documents.htm.

Setting Up Cisco Unity to Use VPIM Networking
This section describes the prerequisites for setting up VPIM Networking, and provides a task list 
containing a high-level view of all of the tasks you need to complete for the setup, and the order in which 
they should be completed. If you are unfamiliar with VPIM Networking, you should first read the “VPIM 
Concepts and Definitions” section on page 7-21 and then review the task list and procedures before 
beginning the setup. Planning is essential to a successful setup.

Prerequisites
Before starting the setup, verify that the following prerequisites have been met.

• Cisco Unity is already installed on the server(s), and they are connected to the network as applicable 
for your installation.

• The remote voice messaging system that Cisco Unity will be networked with is listed in the 
“Support Policy for VPIM Voice Messaging Systems” section of the Cisco Unity System 
Requirements, and Supported Hardware and Software, at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html.

• A license file with a VPIM license has been obtained and installed on the Cisco Unity bridgehead 
server.

• Cisco Unity and Domino meet the requirements as described in the “VPIM Networking 
Requirements” section in Cisco Unity Networking Options Requirements, at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/products_device_support_table09186a0
080531ba9.html.

For installations with multiple Cisco Unity servers that access that same directory, you should first set 
up the servers for Digital Networking as described in the “Digital Networking” chapter before setting up 
VPIM Networking. In order to use VPIM Networking, all the Cisco Unity servers must be at version 
4.0(5) or later. After the Cisco Unity servers have been set up for Digital Networking, verify the 
following settings:

• Verify that the addressing search scope is set to either the dialing domain or the global directory on 
all of the networked servers so that Cisco Unity subscribers, no matter which server they are 
associated with, can address messages to VPIM delivery locations and/or VPIM subscribers. See the 
“Setting the Addressing Search Scope” section on page 2-8 for details.

• If you want outside callers to be able to reach VPIM subscribers from the automated attendant (for 
example, from the opening greeting) or directory assistance:

– Verify that the Cisco Unity server(s) on which the VPIM subscribers will be created are in the 
same dialing domain as the Cisco Unity server that outside callers call into. See the 
“Customizing the Primary Location” section on page 2-8 for details on creating the dialing 
domain, and the “Dialing Domains” section on page 2-15 for background information.
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– Verify that the automated attendant and directory handler(s) search scopes are set to the dialing 
domain scope. See the “Setting the Directory Handler Search Scope” section on page 2-9 and 
the “Setting the Automated Attendant Search Scope” section on page 2-9.

Task List: Setting Up Cisco Unity to Use VPIM Networking
Use the task list that follows to set up VPIM Networking in Cisco Unity. The cross-references take you 
to detailed procedures for the setup. If you are setting up VPIM Networking for messaging between 
Cisco Unity servers in different directories, do these tasks in both Cisco Unity locations.

1. Make decisions about your numbering plan and gather information needed to configure VPIM 
Networking. See the “Making Design Decisions and Gathering Needed Information” section on 
page 7-4.

2. Determine the domain name that will be used for messaging between the remote voice messaging 
system and Cisco Unity. See the “Determining the Domain Name” section on page 7-4.

3. As applicable, configure DNS or HOSTS files. See the “Resolving Names with IP Addresses” 
section on page 7-5.

4. Verify network and SMTP connectivity with the remote voice messaging system. See the “Verifying 
Connectivity with the Remote Voice Messaging System” section on page 7-6.

5. Configure the Interop Gateway. See the “Configuring the Interop Gateway” section on page 7-7.

Do the Following Tasks on the Cisco Unity Server That Is Licensed for VPIM

6. Customize the primary location profile settings. See the “Customizing the Primary Location” 
section on page 7-10.

7. Create delivery locations for each remote voice messaging system. See the “Creating VPIM 
Delivery Locations” section on page 7-10.

8. Optionally, create VPIM subscribers. See the “Creating VPIM Subscribers” section on page 7-14.

9. Optionally, extend identified subscriber messaging to include VPIM subscribers. See the “Extending 
Identified Subscriber Messaging to Include VPIM Subscribers” section on page 7-19.

Finish the Setup:

10. Set up the remote voice messaging system for VPIM. Precisely how this is done depends on the 
voice messaging system. However, you will need to provide the remote system with information 
about Cisco Unity. See the “Gathering Information About Cisco Unity to Configure Another Voice 
Messaging System for VPIM” section on page 7-21.

11. Test the setup to verify that Cisco Unity can exchange messages with the other voice messaging 
system. 

Procedures for Setting Up Cisco Unity to Use VPIM Networking
This section contains all of the procedures necessary to set up Cisco Unity for VPIM Networking. If you 
are unfamiliar with VPIM Networking, you should first read the “VPIM Concepts and Definitions” 
section on page 7-21.
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Making Design Decisions and Gathering Needed Information
Before you begin setting up Cisco Unity for VPIM Networking, be sure to plan for the following, and 
gather the applicable information:

• Review your numbering plan strategy to determine whether you will need to enter prefixes on the 
VPIM delivery location and to determine which numbers to assign as Dial IDs for the primary and 
VPIM delivery locations.

• Decide whether you want Cisco Unity subscribers to use blind addressing or to address messages to 
VPIM subscribers.

• Make note of the following information about the remote voice messaging system: the mailbox 
range, the server name, the domain name, and the IP address.

• Determine the Domino server that will handle outgoing SMTP messages to the remote voice 
messaging system.

• Determine the Domino server on which the Interop Gateway mail file will be located. Make sure that 
the server can route messages to the Domino server that sends outgoing SMTP messages. Also make 
sure that the server can route messages to all Domino servers that contain Cisco Unity subscriber 
mail files, and that all of those servers can route messages to the server on which the Interop 
Gateway mail file will be located.

• Determine the Domino server that will accept incoming SMTP messages from the remote voice 
messaging system, and write down the IP address. (Note that this IP address is paired with the 
Interop Gateway foreign domain name for name resolution.) Make sure that the SMTP Listener task 
is enabled on the server, and that the server can route messages to the Domino server on which the 
Interop Gateway mail file will be located.

Determining the Domain Name
VPIM messages are addressed in the format <Mailbox Number>@<Domain Name>. In order for 
messages to be exchanged between the remote voice messaging system and Cisco Unity, you will need 
to decide on the domain name that the remote voice messaging system will use when addressing 
messages to Cisco Unity subscribers. The domain name will be configured as follows:

• On the remote voice messaging system on the location or node profile that corresponds to 
Cisco Unity. (Refer to the documentation for the remote voice messaging system for additional 
information.)

• On the SMTP Domain Name field on the Network > Primary Location page in the Cisco Unity 
Administrator.

• As the foreign domain name in the Interop Gateway Configuration wizard. (See the “Choosing the 
Interop Gateway Foreign Domain Name” section on page 7-25 for more information.)

If the remote voice messaging system location or node profile that corresponds to Cisco Unity has 
already been configured with a domain name, use that domain name in the procedures that follow. 
Otherwise, consult with the Domino administrator for your organization to determine an appropriate 
domain name to use.
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Domain Name Requirements

The domain name uniquely identifies the messaging system. When choosing domain names used by 
Cisco Unity and the remote voice messaging system, keep the following in mind:

• Cisco Unity and the remote voice messaging system cannot use the same domain name; each system 
must use a unique domain name.

• The complete domain name used by Cisco Unity cannot be a subset of the domain name used by the 
remote voice messaging system. For example, if Cisco Unity is using the domain name cisco.com, 
the remote voice messaging system cannot use names like london.cisco.com, paris-cisco.com, or 
romecisco.com. However, you could use europe.cisco.com for Cisco Unity, and then use the names 
london.cisco.com, paris-cisco.com, and romecisco.com.

Caution Choosing a domain name that does not meet these requirements will result in message delivery failure.

Resolving Names with IP Addresses
VPIM messages are sent over the Internet or any TCP/IP network via SMTP. Therefore, some 
mechanism for name resolution is required for the remote voice messaging server and the Domino 
servers that handle incoming and outgoing SMTP messages. (Depending on your network, this may or 
may not be the same server on which the Interop Gateway mail file will be located.) While any method 
or combination of methods may be used, two common ways to accomplish name resolution are through 
Domain Name System (DNS), and by using HOSTS files.

Whether you use DNS or HOSTS files, you will need to know the fully qualified domain name (FQDN) 
and IP address of the remote voice messaging server. The FQDN is displayed in the Windows System 
Control Panel on the Network Identification tab in the Full Computer Name field. You will also need to 
know the Interop Gateway foreign domain name and the IP address of the Domino server that handles 
incoming SMTP messages.

If your organization uses DNS:

• Add a host address resource (A) record and a mail exchange (MX) record in DNS for the remote 
voice messaging server, if they do not already exist.

• Add an MX record in DNS using the Interop Gateway foreign domain name and the IP address of 
the server that handles incoming SMTP messages to your Domino network.

Refer to the Microsoft Windows or applicable operating system documentation for more information 
about adding A and MX records in DNS.

If your organization does not use DNS, you can use HOSTS files for name resolution. A HOSTS file is 
a text file that contains the mappings of IP addresses to host and domain names. On Microsoft Windows 
systems, the HOSTS file is located in the %windir%\System32\Drivers\Etc directory. Edit the HOSTS 
files as follows:

• On the server that handles outgoing SMTP messages from your Domino network, add an entry to 
the HOSTS file with the FQDN and IP address of the remote voice messaging server.

• Refer to the remote voice messaging server documentation for information on name resolution. 
Typically, you will need to add an entry to the HOSTS file with the Interop Gateway foreign domain 
name and the IP address of the server that handles incoming SMTP mail to your Domino network.
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Verifying Connectivity with the Remote Voice Messaging System
Verify that the server(s) that handle outgoing and incoming SMTP messages have network and SMTP 
connectivity with the remote voice messaging server, and vice versa.

For networking with another voice messaging server, you may need to install and configure an SMTP 
service or gateway on that server. Refer to the documentation of the other voice messaging system for 
information on installing the SMTP service or gateway. Before proceeding, verify that the SMTP service 
or gateway has been installed on the other voice messaging server.

To Verify Network Connectivity with the Remote Voice Messaging Server

Step 1 On the Domino (or relay) server that handles outgoing SMTP messages, open a command prompt 
window.

Step 2 Enter ping <IP address>, where <IP address> is the IP address of the remote voice messaging server.

If you receive no reply, troubleshoot the network connectivity problem until the problem is resolved. 
Then continue with Step 3.

Step 3 Enter ping <Domain name> where <Domain name> is the domain name that will be used to address 
messages to the remote voice messaging server. The domain name in this step is the domain name that 
will be entered on the VPIM delivery location page in the Cisco Unity Administrator when setting up 
VPIM Networking.

Step 4 If you received a reply when pinging the IP address in Step 2, but no replies when pinging the domain 
name in Step 3, refer back to the “Resolving Names with IP Addresses” section on page 7-5. When the 
problem is resolved, continue with Step 5.

Step 5 Test network connectivity in the opposite direction. For systems other than Cisco Unity, consult the 
documentation for information on how to conduct the test, and continue with Step 6. Note that the 
remaining steps in this procedure may not exactly match the steps necessary for your system, so you may 
need to make adjustments.

Step 6 On the remote server, ping the IP address of the local Domino (or relay) server that handles incoming 
SMTP messages.

If you receive no reply, troubleshoot the network connectivity problem until the problem is resolved. 
Then continue with Step 7.

Step 7 On the remote server, ping the domain name, where the domain name is the one that you decided on in 
the “Determining the Domain Name” section on page 7-4.

Step 8 If pinging by domain name fails, refer back to the “Resolving Names with IP Addresses” section on 
page 7-5. When you verify that you have basic network connectivity, continue with the “To Verify SMTP 
Connectivity with the Remote Voice Messaging Server” procedure on page 7-6.

To Verify SMTP Connectivity with the Remote Voice Messaging Server

Step 1 In a command prompt window on the Domino server that handles outgoing SMTP messages, enter telnet 
<RemoteDomainName> 25, where <RemoteDomainName> is the domain name that will be used to 
address messages to the remote voice messaging server.

Step 2 If there is a response, enter ehlo <DomainName>, where <DomainName> is the domain name that you 
decided on in the “Determining the Domain Name” section on page 7-4.

Step 3 If the telnet test was successful, enter quit to end the telnet session.
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Step 4 Test SMTP connectivity in the opposite direction. For systems other than Cisco Unity, consult the 
documentation for information on how to conduct the SMTP connectivity test, and continue with Step 5. 
Note that the remaining steps in this procedure may not exactly match the steps necessary for your 
system, so you may need to make adjustments based on your voice messaging system documentation.

Step 5 On the remote server, attempt to start a telnet session. Enter telnet <DomainName> 25 test, where 
<DomainName> is the domain name that you decided on in the “Determining the Domain Name” section 
on page 7-4.

Step 6 If there is a response, on the remote server, enter ehlo <RemoteDomainName>, where 
<RemoteDomainName> is the domain name of the remote voice messaging server.

Step 7 If either of the telnet tests in Step 5 and Step 6 fails, there is a basic SMTP connectivity problem that 
must be resolved before proceeding with the VPIM Networking setup.

Step 8 With Cisco Unity, the processing of VPIM messages occurs on the Domino server on which the Interop 
Gateway mail file will be located. If this server is not the same as the server that handles incoming and 
outgoing SMTP messages, review your Domino settings to verify:

• That the server that handles incoming SMTP messages is able to route messages to the Domino 
server on which the Interop Gateway mail file will be located.

• That the server on which the Interop Gateway mail file will be located is able to route messages to 
the Domino (or relay) server that handles outgoing SMTP messages.

• That the Domino servers where Cisco Unity subscriber mail files are located can route messages to 
the Domino server where the Interop Gateway mail file is located.

• That the Domino server where the Interop Gateway mail file is located can route messages to the 
Domino servers where Cisco Unity subscriber mail files are located.

Refer to your Domino documentation for more information.

Configuring the Interop Gateway
You can configure the Interop Gateway service—CsDomInteropGty—to run on the Cisco Unity 
bridgehead server, or on any other Cisco Unity server networked to the bridgehead via Digital 
Networking. Note the following:

• Although the Interop Gateway mail file can be located on a Domino server that belongs to a cluster, 
or you can specifically cluster the Interop Gateway mail file, the Interop Gateway monitors only the 
Domino server on which the mail file was created. If the Domino server on which the Interop 
Gateway mail file was created fails-over or is marked busy by the Domino Cluster Manager, the 
Interop Gateway does not monitor the replica of the mail file (which is on another Domino server in 
the cluster). Domino will route messages to the mail file replica, but the messages will not be 
processed by the Interop Gateway until the Domino server on which the mail file was created 
becomes active again.

• Configure the Interop Gateway only on one Cisco Unity server. Configuring multiple Interop 
Gateways is not supported.

• Starting with Domino release 7.0, the default permissions set for the -Default- account on the access 
control list to the mailbox.ntf template do not include permission to replicate or copy documents. 
This permission is required when setting up the Interop Gateway. It can be granted either by adding 
the permission for the -Default- account, or by adding the UnityServers group that was created 
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during Cisco Unity installation to the access control list, and granting permission to replicate or 
copy documents to the group. Refer to the applicable IBM Lotus documentation for information on 
adding this permission.

Caution The mail file used by the Interop Gateway can become quite large. We recommend that you monitor the 
mail file size and compact it as needed to prevent the mail file from consuming too much disk space. 
Refer to your Domino documentation for more information about compacting databases.

To Configure the Interop Gateway

Step 1 On the Cisco Unity server, browse to the directory in which Cisco Unity is installed (the default location 
is C:\CommServer).

Step 2 Double-click UnityDominoInterOpSetup.exe to run the Interop Gateway Configuration wizard.

Step 3 On the Welcome screen, click Next.

Step 4 On the Configure the Interop Gateway screen, click either Use a New Foreign Domain or Use an 
Existing Foreign Domain.

• If you choose to use a new Foreign domain, in the text box, enter the domain name that will be used 
to route VPIM messages to the Interop Gateway mail file. For example, if “domain.com” is the 
domain name for your organization, you can enter voice.domain.com. The Interop Gateway 
Configuration wizard creates a new Foreign domain document with the specified name.

See the “Interop Gateway and VPIM Networking” section on page 7-24 for more information on 
choosing a Foreign domain name.

Caution Changing the foreign domain name after the Interop Gateway Configuration wizard has been 
run is an involved process. Be very careful when entering the foreign domain name or 
choosing one from the list. See the “Changing the Interop Gateway Foreign Domain Name” 
section on page 7-39 for more information.

• If you chose to use an existing Foreign domain, click the Foreign domain name on the list.

Note The Foreign domain name must be a unique domain name in your Domino network, and it must 
be used exclusively by the Interop Gateway.

Step 5 Click Next to go to the Foreign Domain Mail Information screen. If you chose to use an existing Foreign 
domain, the mail file name and the Domino server on which the mail file resides are displayed. Verify 
the information, and skip to Step 6.

If you chose to create a new Foreign domain:

a. Click the down button for the Domino Server list and wait for the list to be populated with all of the 
Domino server names in your network. Choose the server on which the Interop Gateway mail file 
will be created. Although you can type in the server name, you must enter the server name by using 
the hierarchical naming format (for example “ServerName/Org”).

b. In the Mail File Name field, enter the name of the mail file to be monitored by the Interop Gateway 
(for example, interop.nsf). The Interop Gateway Configuration wizard will create the mail file, so 
enter a file name that does not already exist.
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Step 6 Click Next. Choose the Windows account that the Interop Gateway service will log on with. We 
recommend that you choose Local System. However, if you choose an existing Windows account, you 
will need to ensure that it has the same level of permissions as were set by the Permissions wizard during 
Cisco Unity setup for the directory and messaging services account.

Step 7 Click Next and review the summary information to verify that it is correct.

Step 8 Click Finish. The wizard configures and starts the Interop Gateway service on the Cisco Unity server. 
When the wizard finishes, a message box displays to let you know whether the configuration was 
successful.

Note If the system is using the Cisco Unity failover feature, you must run the Interop Gateway 
Configuration wizard first on the primary server and then on the secondary server. When you 
have finished configuring VPIM Networking on the primary Cisco Unity server, run the Interop 
Gateway Configuration wizard on the secondary server, and be sure to use the same Foreign 
domain that you specified above. (You will choose to use an existing Foreign domain.)

To Verify the Interop Gateway Configuration

Do the following procedure to verify that the Interop Gateway is configured properly, that the Interop 
Gateway service is running, and that the foreign domain document and mail file have been created.

Step 1 Open the Services MMC on the Cisco Unity server on which you ran the Interop Gateway Configuration 
wizard. (On the Windows Start menu, click Programs > Administrative Tools > Services.)

Step 2 Verify that the Status for the CsDomInteropGty service is Started, and that the Startup Type is set to 
Automatic.

Step 3 Exit the Services MMC.

Step 4 Open the Domino Administrator.

Step 5 Click the Configuration tab.

Step 6 In the left pane, expand Messaging, and click Domains.

Step 7 Verify that there is a foreign domain document with the name that you specified in the Interop Gateway 
Configuration wizard.

Step 8 Open the foreign domain document.

Caution Do not change any information in the Foreign Domain document. Instead, rerun the Interop 
Gateway Configuration wizard if you need to change information in the document.

Step 9 Click the Mail Information tab, and verify that the Gateway server name and Gateway mail file name 
fields contain the correct information.

Step 10 Close the foreign domain document, and exit Domino Administrator.

Step 11 On the applicable Domino server, open My Computer and browse to the Domino directory to verify that 
the Interop Gateway mail file was created.
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Customizing the Primary Location
If your installation consists of multiple Cisco Unity servers networked via Digital Networking, you may 
have already customized the primary location. In this case, verify that the SMTP Domain Name has been 
entered on the primary locations of all Cisco Unity servers networked via Digital Networking. 
Otherwise, VPIM Networking will not work for the subscribers on the other Cisco Unity servers.

For detailed information about the settings, see the “Primary Location Profile Settings” section on 
page 9-1.

To Customize the Primary Location

Step 1 In the Cisco Unity Administrator, go to the Network > Primary Location > Profile page.

Step 2 Enter a meaningful name for the location.

Step 3 Enter a Dial ID. The Dial ID identifies this location to Cisco Unity.

Step 4 Record a voice name for the location.

Step 5 For the Dialing Domain name:

• If your installation consists of only one Cisco Unity server, and if you plan to enable identified 
subscriber messaging to include VPIM subscribers, enter a dialing domain name.

• If your installation consists of multiple Cisco Unity servers networked via Digital Networking, and 
if this server is integrated with the same phone system as other networked Cisco Unity servers, you 
may have already added this server to a dialing domain. If not, enter the dialing domain name, or 
select it from the available list. The list contains names of dialing domain names already configured 
on at least one other Cisco Unity server in the network.

Note that the dialing domain name is case sensitive and must be entered exactly the same on all of 
the servers. To ensure that all servers are correctly added to the same dialing domain, enter the 
dialing domain name on one Cisco Unity server and wait for the name to replicate to the other 
Cisco Unity servers. By doing so, you also confirm that replication is working correctly among the 
servers. The time that it takes for the primary location data from other Cisco Unity servers to be 
reflected on the local server depends on your network configuration and replication schedule.

Step 6 In the SMTP Domain Name field, enter the domain name that you previously chose in the “Determining 
the Domain Name” section on page 7-4.

Step 7 Click the Save icon.

Creating VPIM Delivery Locations
Create a VPIM delivery location on the bridgehead Cisco Unity server for each remote voice messaging 
system to which subscribers will send messages. If Cisco Unity will be messaging with a large number 
of voice messaging systems, you may prefer to configure only a few delivery locations at this time and 
proceed with the rest of the setup. After verifying that messaging works correctly between Cisco Unity 
and the voice messaging systems for which delivery locations have been configured, you can create the 
rest of the delivery locations.
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For detailed information about the VPIM delivery location settings, see the “VPIM Delivery Location 
Profile Settings” section on page 7-34. Carefully consider the Dial ID that you will assign to the delivery 
location. See the “Guidelines for Assigning Dial IDs and Extensions” section on page 9-2 for detailed 
information about choosing a Dial ID.

You can create VPIM delivery locations by using the Cisco Unity Administrator or the Cisco Unity Bulk 
Location Import wizard. See the following sections:

• Using the Cisco Unity Administrator to Create VPIM Delivery Locations, page 7-11

• Using the Cisco Unity Bulk Import Wizard to Create VPIM Delivery Locations, page 7-12

• Modifying Existing Delivery Locations by Using the Cisco Unity Bulk Import Wizard, page 7-13

Using the Cisco Unity Administrator to Create VPIM Delivery Locations

You can create VPIM delivery locations one at a time by using the Cisco Unity Administrator.

To Create VPIM Delivery Locations by Using the Cisco Unity Administrator

Step 1 In the Cisco Unity Administrator, go to the Network > Delivery Locations > Profile page.

Step 2 Click the Add icon.

Step 3 Enter a meaningful name for the location.

Step 4 Enter the Dial ID, which identifies the location in Cisco Unity, and which subscribers use to blind 
address messages to recipients at this location.

Step 5 Select VPIM as the Destination Type for the location.

Step 6 Click Add.

Step 7 Record a voice name for the location.

Step 8 Enter the Internet-addressable SMTP domain name of the system on the TCP/IP network that handles 
messages for the remote voice messaging system.

Step 9 If needed to accommodate your numbering plan, or if there is more than one VPIM delivery location 
with the same domain name, enter a number in the Remote Phone Prefix field.

Note Subscribers do not enter this prefix when addressing messages. However, on outgoing messages, 
the Interop Gateway adds the prefix to the beginning of the recipient mailbox number to form 
the To address. On incoming messages, the Interop Gateway expects this same prefix to be the 
leading digits of the From mailbox number and strips these digits before determining the sending 
mailbox number.

Step 10 If needed to accommodate your numbering plan, enter a number in the Cisco Unity Phone Prefix field.

Note On outgoing messages, the Interop Gateway adds this prefix to the beginning of the sender 
mailbox number to form the From address. On incoming messages, the Interop Gateway expects 
this same prefix to be the leading digits of the To mailbox number and strips these digits prior 
to determining the matching Cisco Unity recipient ID.

Step 11 Indicate whether incoming messages from this VPIM location should be converted to another audio 
format.
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Step 12 Indicate whether outbound messages to this VPIM location should be converted to another audio format. 
If the remote system is Cisco Unity, typically you choose Do Convert Outgoing Messages. For systems 
other than Cisco Unity, typically you choose G.726.

Step 13 Optionally, check the Sender’s Recorded Name and/or Sender’s vCard check box(es). Some systems 
have the capability of using this information to create directory entries.

Step 14 Click the Save icon.

Using the Cisco Unity Bulk Import Wizard to Create VPIM Delivery Locations

The Cisco Unity Bulk Import wizard allows you to create or modify multiple delivery locations at once 
by importing data in a CSV file. If you have already created delivery locations, you can run Cisco Unity 
Bulk Import to export the data about the delivery locations to a CSV file.

Use the following procedure to prepare your CSV file. To learn more about preparing a CSV file for use 
with the Cisco Unity Bulk Import wizard—including information on the required and optional column 
headers for your CSV file—refer to the Cisco Unity Bulk Import wizard Help.

To Prepare a CSV File for Creating VPIM Delivery Locations

Step 1 Create a CSV file in a spreadsheet application (or another applicable application) on the Cisco Unity 
server, or in a directory that you can browse to from the server.

Step 2 Enter the required column headers in the first row. Column headers must be in uppercase, separated by 
commas, and spelled as indicated below:

DTMF_ACCESS_ID, DISPLAY_NAME, SMTP_DOMAIN_NAME

Step 3 If desired, add optional column headers to the first row. Be sure to separate the column headers with 
commas.

Step 4 Add the data for the delivery locations in the subsequent rows. When finished:

• Confirm that each row contains the applicable data corresponding to each column header.

• Confirm that the data is separated by commas, and that no tabs, spaces, or semicolons separate the 
data in the file.

• If any data includes a space, quotes, or commas, contain it within quotes.

• Note that each row does not have to contain data in the optional columns.

Step 5 Save the file as a CSV file.

Step 6 Continue with the “To Create VPIM Delivery Locations by Using the Cisco Unity Bulk Import Wizard” 
procedure on page 7-12.

To Create VPIM Delivery Locations by Using the Cisco Unity Bulk Import Wizard

Step 1 Before you run the Cisco Unity Bulk Import wizard, disable virus-scanning services and 
intrusion-detection software on the Cisco Unity server, if applicable. Otherwise, the Cisco Unity Bulk 
Import wizard may run slowly.

Step 2 On the Cisco Unity server, on the Windows Start menu, click Programs > Cisco Unity > Cisco Unity 
Bulk Import.
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Step 3 On the Welcome page, click Next.

Step 4 On the Select Import Operation, in the Locations section, click CSV File, and then click Next.

Step 5 On the Select Location Operation page, click Create New Locations, and then click Next.

Step 6 On the Type of Locations page, click VPIM, and then click Next.

Step 7 On the Files page, specify the name and location of the input file.

Step 8 Specify the name and location of the output file, or use the default location and file name, which is based 
on the input file. For example, if the input file is C:\Temp\VPIM_Locations.csv, the default output file 
will be C:\Temp\VPIM_Locations.out.csv.

Step 9 Click Next to proceed to the Valid Location Data page, which displays a table with validated rows of 
data from the input CSV file. If you do not want to import a row of data, uncheck the check box in the 
first column of the row.

If errors were found in any of the rows, you can click the Errors link at the bottom of the page to open 
the output CSV file to correct the errors, or you can ignore the errors for now and proceed with the 
import.

Step 10 Click Next to start the import process and display the Creating Locations page, which provides status 
information about the import.

Step 11 When the delivery locations are created, click Next to display the Cisco Unity Bulk Import Wizard 
Finished page, which displays summary information.

Step 12 If you had import errors, continue with the “To Correct Errors That Occurred When Importing Delivery 
Location Data from a CSV File” procedure on page 7-13.

To Correct Errors That Occurred When Importing Delivery Location Data from a CSV File

Step 1 Browse to the directory location of the output file that you specified during the import. (The default 
location and file name is based on the input file. For example, if the input file is 
C:\Temp\VPIM_Locations.csv, the default output file will be C:\Temp\VPIM_Locations.out.csv.) 

This file contains all of the records that were not imported.

Step 2 Use a text editor to open the output file.

Step 3 Correct any records in the output file by using the error information listed in the Results column of the 
file.

Step 4 When you have finished editing the output file, save it as a CSV file with a new name.

Step 5 Run the Cisco Unity Bulk Import wizard again with the new CSV file.

Step 6 Repeat this procedure until all delivery locations are created without error.

Modifying Existing Delivery Locations by Using the Cisco Unity Bulk Import Wizard

If you want to use the Cisco Unity Bulk Import wizard to make modifications to existing delivery 
locations, you will need to create a CSV file for the modifications. We recommend that you run the 
Cisco Unity Bulk Import wizard to export your existing delivery location data to a CSV file, and then 
edit the CSV file to use for the modification.
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Note that the DTMF_ACCESS_ID column is used as the primary key to find the existing delivery 
location, and therefore it cannot be modified by the Cisco Unity Bulk Import wizard.

Creating VPIM Subscribers
You may prefer to create only a few VPIM subscribers at this point, for testing purposes, until you verify 
that Cisco Unity and the remote system can successfully exchange messages. After you have confirmed 
that messaging between Cisco Unity and the remote system is working correctly, you can finish creating 
the VPIM subscribers. Note that you must first create VPIM delivery locations before creating VPIM 
subscribers, and the VPIM subscribers must be created on the same Cisco Unity server as the VPIM 
delivery locations.

You can create VPIM subscriber accounts by using the Cisco Unity Bulk Import wizard or the 
Cisco Unity Administrator. See the following sections:

• Before Creating Subscriber Accounts, page 7-14

• Using the Cisco Unity Bulk Import Wizard to Create Multiple Subscriber Accounts, page 7-16

• Using the Cisco Unity Administrator to Create VPIM Subscriber Accounts, page 7-18

• After Creating Subscriber Accounts, page 7-19

Before Creating Subscriber Accounts

This section lists—in order—the issues that you must consider before creating VPIM subscribers. VPIM 
subscribers can be created only on a Cisco Unity bridgehead server. Do the following tasks on the 
Cisco Unity bridgehead server where you will be adding the VPIM subscribers.

1. Cisco Unity Configuration and Permissions

If you are unsure whether the account that you are using has sufficient rights and permissions to create 
subscribers, or whether Cisco Unity is properly configured to work with your message store, use the 
following “To Check Cisco Unity Setup and Permissions by Using the Cisco Unity SysCheck Tool” 
procedure.

To Check Cisco Unity Setup and Permissions by Using the Cisco Unity SysCheck Tool

Step 1 On the Cisco Unity server desktop, double-click the Cisco Unity Tools Depot icon.

Step 2 In the left pane of the Tools Depot window, in the Diagnostic Tools directory, double-click SysCheck.

Step 3 On the Welcome to the Cisco Unity Configuration Wizard page, click Select Configuration Tests, and 
click Next.

Step 4 Uncheck the boxes for the message stores that are not connected to Cisco Unity.

Step 5 Click Test.

Step 6 In the Test Results box, click the link provided to view the test results.

Step 7 If no errors are reported, proceed to Step 8. Otherwise, do the following sub-steps:

a. Follow the advice offered in the Resolution column to correct each configuration or permissions 
error.

b. Return to the Completing the Check Unity Configuration Wizard page, and click Finish.

c. Repeat Step 2 through Step 7 until no errors are reported.
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Step 8 Click Finish.

2. Classes of Service

A class of service (COS) defines limits and permissions for subscribers who use Cisco Unity. For 
example, a COS dictates the maximum length of subscriber messages and greetings. Although most COS 
settings are not applicable to VPIM subscribers, they still must be members of a COS. In the Cisco Unity 
Administrator, a COS is specified in each subscriber template; thus, a subscriber is assigned to the COS 
that is specified in the template upon which the subscriber account is based. Cisco Unity includes 
predefined classes of service, which you can modify. You can also create new classes of service. For 
details, see the “Class of Service Settings” chapter in the Cisco Unity System Administration Guide.

3. Restriction Tables

Each COS specifies a restriction table for call transfers, one for message notification, and one for fax 
deliveries. Cisco Unity applies the restriction table associated with the COS of a subscriber, and displays 
an error message if the phone number is not allowed. Cisco Unity comes with predefined restriction 
tables, which you can modify.

Although most restriction table settings do not apply to VPIM subscribers because they cannot log on to 
Cisco Unity or use the Cisco Personal Communications Assistant (PCA), administrators can enter call 
transfer numbers for VPIM subscribers. For security purposes, you should modify the restriction table 
used for transfers in the COS to which VPIM subscribers belong, as necessary. For details, see the 
“Restriction Tables” chapter in the Cisco Unity System Administration Guide.

4. Public Distribution Lists 

Public distribution lists are used to send voice messages to multiple subscribers at the same time. 
Cisco Unity assigns new subscribers to the public distribution lists that are specified in the template on 
which the subscriber account is based. For details, see the “Public Distribution List Settings” chapter in 
the Cisco Unity System Administration Guide.

Public distribution lists correspond to groups in Domino and are listed in the Notes address book. To 
help prevent others from sending e-mail to VPIM subscribers, you may want to create lists that contain 
only VPIM subscribers, and add text similar to “Voice Mail Only” to the list names. Additionally, you 
may also want to exclude VPIM subscribers from the All Subscribers distribution list or any other 
distribution list that contains regular subscribers.

5. Subscriber Templates

In the Cisco Unity Administrator, you can specify settings for a group of subscribers by using a 
subscriber template. Subscriber templates contain settings that are applicable for subscribers of a 
particular type, such as a department. The settings from the template you choose are applied to 
subscriber accounts as the accounts are created. Cisco Unity comes with a default subscriber template, 
which you can modify, and you can create an unlimited number of additional templates. For more details, 
see the “Subscriber Template Settings” chapter in the Cisco Unity System Administration Guide.

VPIM subscribers have corresponding Domino Person documents that have “Other Internet Mail” set in 
the Mail System field, and they are listed in the Notes address book. To help prevent others from sending 
e-mail to VPIM subscribers, you may want to add text similar to “Voice Mail Only” to the VPIM 
subscriber names.

Note The Cisco Unity System Administration Guide is available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/products_administration_guide_book09186
a008043ea45.html.
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Using the Cisco Unity Bulk Import Wizard to Create Multiple Subscriber Accounts

The Cisco Unity Bulk Import wizard allows you to create multiple subscriber accounts at the same time 
by importing user data from a comma-separated value (CSV) file. CSV is a common text file format for 
moving data from one data store to another. As long as user data contained in the CSV file is formatted 
correctly, you can use it to create new Person documents at the same time that you create subscriber 
accounts, or you can use it to create VPIM subscribers with existing Person documents. (The 
corresponding Person documents have “Other Internet Mail” set in the Mail System field.)

If you choose to create subscriber accounts with existing Person document data, note that the Forwarding 
address field in the Person documents for the imported users is overwritten with the extension address 
that is used for addressing voice messages to the remote voice messaging systems. Thus, the imported 
objects can no longer be used for outbound message addressing to remote e-mail addresses.

Use the following procedure to prepare your CSV file. To learn more about preparing a CSV file for use 
with the Cisco Unity Bulk Import wizard—including information on the required and optional column 
headers for your CSV file—refer to Cisco Unity Bulk Import wizard Help.

To Prepare a CSV File for Creating VPIM Subscriber Accounts

Step 1 Save the data which you will use to create Cisco Unity accounts as a CSV file.

As a best practice, do not include more than 7,500 records in a single CSV file, as you may encounter 
unexpected results when the Cisco Unity Bulk Import wizard imports the data.

Step 2 Copy the CSV file to the Cisco Unity bridgehead server or to a directory that you can browse to from 
the server.

Step 3 Open the CSV file in a spreadsheet application or another application with which you can edit and 
reorganize the data. Do the following:

• Confirm that the data is separated by commas, and no tabs, spaces, or semicolons separate the data 
in the file.

• If any data includes a space, quotes, or commas, contain the characters within quotes.

Step 4 Rearrange the data so that the columns are in the same order as the column headers that you will add in 
Step 5. The order of the column headers does not matter, though it is good practice to set up your CSV 
file as indicated here. For example, the columns of data in this sample are sorted so that the last name of 
the user is followed by the first name, the short name, the extension (DTMF_ACCESS_ID), and then by 
the remote mailbox number (REMOTE_USER_ID):

Abade,Alex,aabade,2001,3000
Bader,Kelly,kbader,2002,3100
Campbell,Terry,tcampbell,2003,3200
Cho,Li,lcho,2004,3300

Step 5 Enter the required column headers above the first row of data. Column headers must be in uppercase, 
separated by commas, and spelled as indicated below:

LAST_NAME,FIRST_NAME,SHORT_NAME,DTMF_ACCESS_ID,REMOTE_USER_ID

Note The examples in this procedure illustrate how to set up a CSV file so that the Cisco Unity Bulk 
Import wizard creates subscriber accounts and new Person documents at the same time. If you 
choose to create new subscriber accounts with existing Person document data, you must remove 
the LAST_NAME and FIRST_NAME column headers and data in your CSV file.
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Step 6 If desired, add optional column headers to the first row, and the corresponding data that you want to 
import in the subsequent rows below. As you do so, confirm that:

• Column headers and data are separated by commas. Note that every row does not have to contain 
data for any optional column header(s).

• Any data that includes a space, quotes, or commas is contained within quotes.

Step 7 To associate the VPIM subscribers in the CSV file with a delivery location, you can either choose from 
the list of defined delivery locations presented by the Cisco Unity Bulk Import wizard during the import, 
or you can add the DELIVERY_LOCATION_ID column to the CSV file.

The DELIVERY_LOCATION_ID column contains the dial ID of a delivery location with which the 
external subscriber will be associated. This value corresponds to the Dial ID field on the Network > 
Delivery Locations > Profile Page in the Cisco Unity Administrator. If this column header is omitted, or 
if a row does not contain a value, the delivery location that the Cisco Unity Bulk Import wizard prompts 
for is used as a default. You can import external subscribers for multiple delivery locations by using one 
CSV file.

Step 8 If your CSV file contains columns of data that you do not want to import, delete the columns. 
Alternatively, you can title one column NOTES. The Cisco Unity Bulk Import wizard ignores data 
beneath any NOTES column header, but the wizard does not support more than one NOTES column in 
a CSV file.

Step 9 Confirm that each row contains the appropriate data corresponding to each column header.

Step 10 Save the file as a CSV file.

Step 11 Continue with the “To Create VPIM Subscriber Accounts by Using the Cisco Unity Bulk Import 
Wizard” procedure on page 7-17.

To Create VPIM Subscriber Accounts by Using the Cisco Unity Bulk Import Wizard

Step 1 Disable virus-scanning services and intrusion-detection software on the bridgehead Cisco Unity server, 
if applicable. Otherwise, the Cisco Unity Bulk Import wizard may run slowly. Refer to Cisco Unity Bulk 
Import wizard Help for procedures.

Step 2 On the bridgehead Cisco Unity server, on the Windows Start menu, click Programs > Cisco Unity > 
Cisco Unity Bulk Import.

Step 3 Follow the on-screen instructions.

To learn more about the options presented in the dialog boxes that appear as the wizard proceeds, click 
Help.

Step 4 When prompted to choose the type of subscriber that you want to create, click VPIM.

Step 5 Click Next, and proceed through the wizard. If the wizard reports any errors, you can:

• Click OK to continue with the import, and fix the errors later.

• Fix the errors. See the “Correcting CSV Import Errors” section on page 7-18 for details.

Step 6 When the subscriber accounts are created, click Finish.

Step 7 If you had import errors, but in Step 5 you chose to correct them later, see the “Correcting CSV Import 
Errors” section on page 7-18.
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If you had no import errors, or if all errors have now been corrected, see the “After Creating Subscriber 
Accounts” section on page 7-19.

Correcting CSV Import Errors

The error log file contains data that the Cisco Unity Bulk Import wizard could not import. The wizard 
reports the first error it detects in a row in a CSV file. When you have corrected that error, the wizard 
may detect additional errors in the same row when the data is imported again. Thus, you may need to 
repeat the correction process—running the Cisco Unity Bulk Import wizard and correcting an 
error—several times to find and correct all errors.

The output log file contains all the records that were not imported. You can save it as a CSV file, and use 
it when you run the Cisco Unity Bulk Import wizard again. Note that each time you run the Cisco Unity 
Bulk Import wizard, the error and output log files are overwritten (unless you specify new names for the 
files).

To correct import errors, do the following “To Correct Errors That Occurred When Importing Data from 
a CSV File” procedure.

To Correct Errors That Occurred When Importing Data from a CSV File

Step 1 Browse to the directory that contains the error log file you specified during the import. (The default 
location and file name is C:\Error.log.)

Step 2 Use a text editor to open the error log file. You will use the error codes in the file to make corrections.

Step 3 Browse to the directory location of the output log file you specified during the import. (The default 
location and file name is C:\Output.log.)

Step 4 Use a text editor to open the output log file.

Step 5 Correct any records in the output file that are listed as errors in the error log file.

Step 6 When you have finished editing the output log file, save it as a CSV file with a new name.

Step 7 Run the Cisco Unity Bulk Import wizard again with the CSV file that you saved in Step 6.

Step 8 Repeat this procedure until all subscriber accounts are created without error, and then proceed to the 
“After Creating Subscriber Accounts” section on page 7-19.

Using the Cisco Unity Administrator to Create VPIM Subscriber Accounts

By using the Cisco Unity Administrator, you can create VPIM subscriber accounts one at a time. When 
you add a new VPIM subscriber account, a corresponding Person document that has “Other Internet 
Mail” set in the Mail System field is created in the Domino directory.

To create an VPIM subscriber account, do the following “To Add a New VPIM Subscriber by Using the 
Cisco Unity Administrator” procedure.

To Add a New VPIM Subscriber by Using the Cisco Unity Administrator

Step 1 In the Cisco Unity Administrator, go to the Subscribers > Subscribers > Profile page.

Step 2 Click the Add icon.
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Step 3 Click New and select VPIM from the list.

Step 4 Enter the First Name and Last Name.

Step 5 Enter the Extension of the VPIM subscriber on Cisco Unity. This is the number that Cisco Unity 
subscribers use when addressing a message to this VPIM subscriber.

Step 6 Select the Subscriber Template to use.

Step 7 Enter the Remote Mailbox Number, which is the number that the remote voice messaging system uses 
to route messages to this VPIM subscriber.

Step 8 Select the Delivery Location with which the subscriber is associated.

Step 9 Click Add.

Step 10 On the subscriber record, customize settings as applicable, and then click the Save icon.

After Creating Subscriber Accounts

After creating VPIM subscriber accounts, consider the following:

• It takes a few minutes for the newly-created subscriber account to be available to receive messages.

• You can make changes to subscriber settings for individual accounts in the Cisco Unity 
Administrator. For details, see the “Subscriber Settings” chapter in the Cisco Unity System 
Administration Guide. The guide is available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/products_administration_guide_book09
186a008043ea45.html.

• When you want to modify unique subscriber settings—such as primary or alternate extensions—for 
multiple subscribers at once, you can (re)run the Cisco Unity Bulk Import wizard. To learn more, 
refer to Cisco Unity Bulk Import wizard Help.

• When a subscriber leaves the organization or otherwise no longer needs a Cisco Unity account, you 
can delete the subscriber account.

See the “Deleting VPIM Subscribers” section on page 7-30 for details.

 Extending Identified Subscriber Messaging to Include VPIM Subscribers
When a person on a remote voice messaging system who has a corresponding VPIM subscriber account 
calls a Cisco Unity subscriber and leaves a message, by default Cisco Unity will not identify the message 
as being from the VPIM subscriber. For Cisco Unity to identify callers whose calling number matches 
the extension or alternate extension of a VPIM subscriber, identified subscriber messaging (ISM) must 
be extended to include VPIM subscribers. See the following sections as applicable to your installation.

• Installation with Multiple Cisco Unity Servers Networked via Digital Networking, page 7-19

• Single-Server Installations, page 7-20

Installation with Multiple Cisco Unity Servers Networked via Digital Networking

In installations with multiple Cisco Unity servers networked via Digital Networking, enabling ISM to 
include VPIM subscribers requires the following:

1. The Cisco Unity servers must be connected to the same phone system or phone system network as 
described in the “Dialing Domains” section on page 2-15.
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2. The servers must be configured to be in the same dialing domain, as described in the “Customizing 
the Primary Location” section on page 7-10.

3. The automated attendant search scope on each server must be set to the dialing domain as described 
in the “Setting the Automated Attendant Search Scope” section on page 2-9.

4. Identified subscriber messaging on each server must be enabled as described in the “Enabling 
Identified Subscriber Messaging” section on page 7-20.

5. Identified subscriber messaging on each server must be enabled for VPIM subscribers as described 
in the “Extending Identified Subscriber Messaging” section on page 7-20.

Single-Server Installations

In installations with only one Cisco Unity server, enabling ISM to include VPIM subscribers requires 
the following:

1. The server must be configured with a dialing domain name, as described in the “Customizing the 
Primary Location” section on page 7-10.

2. Identified subscriber messaging must be enabled as described in the “Enabling Identified Subscriber 
Messaging” section on page 7-20.

3. Identified subscriber messaging must be enabled for VPIM subscribers as described in the 
“Extending Identified Subscriber Messaging” section on page 7-20.

Enabling Identified Subscriber Messaging

Note If the system is using failover, you must make this change on both the primary and secondary servers 
because the setting is stored in the registry.

To Enable Identified Subscriber Messaging

Step 1 In the Cisco Unity Administrator, go to the System > Configuration Settings page.

Step 2 In the Identified Subscriber Messaging section, uncheck the Subscribers Are Identified as Message 
Senders Only If They Log On check box.

Identified subscriber messaging for subscribers on the same Cisco Unity server is enabled when the 
check box is unchecked. By default, the box is unchecked.

Step 3 Click the Save icon.

Extending Identified Subscriber Messaging

After identified subscriber messaging has been enabled, you must extend it to include VPIM subscribers.

To Extend Identified Messaging

Step 1 On the Cisco Unity server desktop, double-click the Cisco Unity Tools Depot icon.

Step 2 In the left pane, under Administrative Tools, double-click Advanced Settings Tool.
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Step 3 In the Unity Settings pane, click Networking – Enable Identified Subscriber Messaging (ISM) for 
AMIS, Bridge, and VPIM Subscribers.

Step 4 In the New Value list, click 1, then click Set.

Step 5 When prompted, click OK.

Step 6 Click Exit.

Step 7 Restart Cisco Unity for the registry setting to take effect.

Gathering Information About Cisco Unity to Configure Another Voice 
Messaging System for VPIM

Configuring another voice messaging system to exchange VPIM messages with Cisco Unity may require 
the following information:

• The Interop Gateway foreign domain name.

• The Cisco Unity phone prefix (if any) and Remote phone prefix (if any) entered on the 
corresponding delivery location page.

• Mailbox number range for Cisco Unity subscribers.

Cisco Unity expects incoming VPIM messages to be formatted as follows: 
<UnityPhonePrefix+UnitySubscriberExtension@ForeignDomainName>. These specific properties are 
configured in Cisco Unity, but similar information will need to be configured in the other voice 
messaging system.

VPIM Concepts and Definitions
The following sections explain VPIM concepts in detail:

• Introduction to VPIM, page 7-22

• VPIM Networking and Locations, page 7-24

• Interop Gateway and VPIM Networking, page 7-24

• Message Addressing Options, page 7-25

• VPIM Networking and Blind Addressing, page 7-26

• VPIM Subscribers, page 7-27

• Identified Subscriber Messaging, page 7-28

• Live Reply to VPIM Subscribers, page 7-29

• Deleting VPIM Subscribers, page 7-30

• Extension Addresses, page 7-30

• Migrating Subscribers from Another Voice Messaging System to Cisco Unity, page 7-31

• Considerations for Digitally Networked Cisco Unity Servers, page 7-32

• Phone Prefixes, page 7-33

• Audio Format Considerations, page 7-33
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Introduction to VPIM
VPIM Networking allows the exchange of voice, fax, and text messages between different voice 
messaging systems over the Internet or any TCP/IP network. VPIM is an industry-standard protocol 
based on the Simple Mail Transfer Protocol (SMTP) and the Multi-Purpose Internet Mail Extension 
(MIME) protocol.

VPIM enables organizations to link different voice messaging systems and to provide seamless voice 
message sending, receiving, forwarding, and replying between these systems. An organization can 
exchange messages over a TCP/IP-based intranet, or over the Internet, or a combination of the two. In 
simplified terms, voice messages are exchanged between the systems like regular e-mail.

Figure 7-1 VPIM Networking Enables Messaging Between Different Systems Over a TCP/IP Network

The VPIM specification defines the format of messages and message addresses, and how messages are 
exchanged between mail servers. VPIM does not specify how the mail servers interact with client 
applications, or how they interface with end users. This allows many different kinds of existing systems 
to support VPIM. For more information about VPIM, refer to the Open Group VPIM website.

VPIM Messages

VPIM messages are made up of one or more MIME-encoded parts. The VPIM specification allows for 
optional MIME parts for spoken name and for forwarded, fax, and text messages. VPIM messages can 
also include a vCard, an electronic business card that includes phone number, text name, and e-mail 
address. Cisco Unity allows you to specify whether the voice name and vCard of the sender will be sent 
with outgoing messages. If incoming messages include a voice name, it is played as part of the message. 
If a vCard is attached to an incoming message, the recipient can look at the vCard data in the Notes 
client.

VPIM fax encoding is based on the TIFF-F specification, and the vCard format is based on the Internet 
adaptation of the Versit vCard specification.

Figure 7-2 shows a sample VPIM message. Only a portion of the MIME encoding of the spoken name 
and voice message parts are shown because they are very long.
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Figure 7-2 Sample VPIM Message

VPIM Addresses

A VPIM address is in the same format as a typical SMTP e-mail address: localpart@hostpart. The 
right-hand side of the address is the domain name of the system on the TCP/IP network that handles 
messages. The left-hand side of the address is a unique identifier for the user. Typically, the left-hand 
side is the subscriber mailbox number or the mailbox number with a prefix.
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From Address

vCard Information

Spoken Name

Voice Message

Date: Fri, 08 Nov 2002 17:39:03 GMT
From: Kelly Bader <4258001@unitydomain1.cisco.com>
To: 2534001@unitydomain2.cisco.com
MIME-Version: 1.0 (Voice 2.0
Content-Type: multipart/Voice-Message; boundary="==AvVoice==1c5f4b12-
cc0f-40de-b14b-b129b17326bc"
Message-ID: edb0cc15-3ee6-44dc-aa5e-d5f88a4d68ec
Content-Transfer-Encoding: 7bit
Subject: testing

--==AvVoice==1c5f4b12-cc0f-40de-b14b-b129b17326bc
Content-Type: text/directory; charset=us-ascii; profile=vCard
Content-Transfer-Encoding: 7bit
Content-Disposition: attachment;
   filename="Kelly Bader.vcf"

BEGIN:vCard
FN:Kelly Bader
EMAIL;TYPE=INTERNET;TYPE=VPIM:4258001@unitydomain1.cisco.com
TEL:4258001
VERSION: 3.0
END:vCard

--==AvVoice==1c5f4b12-cc0f-40de-b14b-b129b17326bc
Content-Type: Audio/32KADPCM
Content-Transfer-Encoding: base64
Content-Disposition: inline; voice=Originator-Spoken-Name

IkIjIyL/EiESIeId//EiIjIiHxER8fIvH+Hy/u/vHx8TH/H/H+EfEfH+/v/v/xI/ERIiLvLy8iEh
8hEeEfER/+///+/t7/3/Ee7v/e7//O8d7//+7f7+Hf///u384eL//x//8v/h8S8R8f/xER4RMR8S
<< The rest of the MIME encoding of the spoken name has been deleted. >>
7/8e0Q==

--==AvVoice==1c5f4b12-cc0f-40de-b14b-b129b17326bc
Content-Type: Audio/32KADPCM
Content-Transfer-Encoding: base64
Content-Description: VPIM Message
Content-Disposition: inline; voice=Voice-Message
Content-ID: c92d2891-1f7c-4c48-9ac3-a4194253f984

q3JT8tPcHO7vz4v+7t4e7+4/EvEy8//+/RERIjM2H/HfzPH93+79yh8+4S8hFOzBEd5Pzu0zIsFM
8iQT0R3tERLyMc280e4r3t3hMR4eofLPPELv4+4hP/7TIUHvHuIiH+8cv+oe7PEeH77+wR8d7CHS
/LwSXkMz4i8fztEaIfIj8fHs7d/+3xIh3KHdO97/H+7yJC7P0hFPIvIdQt8h0i4uH8T+UzHSzczT
<< The rest of the MIME encoding of the voice message has been deleted. >>

--==AvVoice==1c5f4b12-cc0f-40de-b14b-b129b17326bc-- 

To Address
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For example, an outgoing VPIM message to Terry Campbell with the remote mailbox number 2233 could 
be addressed:

To: 2233@remotevoicemailsystem.com

If it is necessary to accommodate the numbering plan for your organization, the address can also contain 
a prefix:

To: 8882233@remotevoicemailsystem.com

VPIM addresses are created by the Interop Gateway when sending VPIM messages; they are not entered 
by subscribers when addressing messages.

VPIM Networking and Locations
Central to how you set up VPIM Networking is a Cisco Unity object called a location. Each Cisco Unity 
server is associated with one location referred to as the default or primary location, which is created 
during installation and which cannot be deleted. When setting up VPIM Networking, you use the 
Cisco Unity Administrator to give the primary location a new name and a Dial ID (which is an identifier 
for the location within Cisco Unity), enter the SMTP domain name, and customize other properties as 
applicable. See the “Primary Location Profile Settings” section on page 9-1 for more information.

You create a delivery location in the Cisco Unity Administrator to correspond to each remote voice 
messaging system with which Cisco Unity communicates. Delivery locations contain the information 
that Cisco Unity needs to exchange messages with other VPIM-compliant voice messaging systems. A 
VPIM delivery location contains the SMTP domain name of the system on the TCP/IP network that 
handles messages for the remote voice messaging system. See the “VPIM Delivery Location Profile 
Settings” section on page 7-34 for more information.

Location data is stored both in the SQL database on the Cisco Unity server and in the Domino Directory. 
In organizations with multiple Cisco Unity servers networked together, the location data replicates to all 
of the Cisco Unity servers in the network. This means that delivery locations need to be created only on 
one Cisco Unity server in the network. The Cisco Unity server on which delivery locations are created 
is referred to as the bridgehead server. See the “Considerations for Digitally Networked Cisco Unity 
Servers” section on page 7-32 for more information.

Interop Gateway and VPIM Networking
The Interop Gateway for Domino is a Cisco Unity service (called CsDomInteropGty) that enables 
messaging between Cisco Unity and other voice messaging systems. The Interop Gateway files are 
copied to the Cisco Unity server during setup; however, the Interop Gateway is not installed as a service 
until you run the Interop Gateway Configuration wizard when configuring Cisco Unity for VPIM 
Networking. The Interop Gateway Configuration wizard configures and starts the service. In the Interop 
Gateway Configuration wizard, you specify a Domino Foreign domain name (for example, 
“voicemail.domain.com”) and mail file that VPIM messages will be routed through.

When subscribers use the phone to address a message to an VPIM recipient, Cisco Unity constructs a 
“to” address in the form VPIM:<Location Dial ID>_<Remote Mailbox>@<ForeignDomain> for the 
message. Domino routes the message to the mail file that you specified in the Interop Gateway 
Configuration wizard. The Interop Gateway monitors this mail file. For an outbound message to a VPIM 
recipient, the Interop Gateway constructs a MIME message according to the VPIM specification, and 
hands the message back to Domino for delivery via SMTP.
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Incoming VPIM voice messages received by the Domino server with the SMTP Listener service are 
routed to the Interop Gateway mail file for processing, after which the Interop Gateway sends the 
message back to Domino, which routes it to the subscriber mail file.

Choosing the Interop Gateway Foreign Domain Name

The Foreign domain name to be used by the Interop Gateway can be whatever you would like it to be. 
As a best practice, however, we recommend that you use a name that follows the format 
<Name>.<DomainName>, where <Name> is a descriptive term and <DomainName> is the domain 
name of your organization, for example, UnityVPIM.mydomain.com. By following this convention, you 
will be able to add a host address resource (A) record and a mail exchange (MX) record in DNS using 
the Interop Gateway foreign domain name and the IP address of the Domino server that handles 
incoming SMTP messages. Even if you use HOSTS files instead of DNS, the <Name>.<DomainName> 
format may be required by the remote voice messaging system. Refer to the documentation for the 
remote voice messaging system for information.

The Foreign domain name must be unique, meaning there can be no other Domain documents in Domino 
that have a domain name that matches what you choose for the Interop Gateway Foreign domain name. 
Additionally, the Foreign domain must not be used by any other program, such as a fax server. (Typically, 
fax servers use Foreign domains for processing and routing faxes.)

See the “Configuring the Interop Gateway” section on page 7-7 for information on running the Interop 
Gateway Configuration wizard.

Message Addressing Options
Cisco Unity provides the following ways to address messages to individuals by using a VPIM-compliant 
voice messaging system:

• Blind addressing—Blind addressing allows Cisco Unity to send messages without having specific 
information about the recipients on the remote voice messaging system (such as their names and 
mailbox numbers). To address a message to someone on another voice messaging system, 
subscribers enter the delivery location Dial ID and the remote mailbox number of the recipient. See 
the “VPIM Networking and Blind Addressing” section on page 7-26 for more information.

• VPIM subscribers—With VPIM subscribers, Cisco Unity has information about the remote users, 
such as their names and extensions. Subscribers address messages to VPIM subscribers the same 
way that they address messages to regular Cisco Unity subscribers—by extension or by spelling the 
name of the recipient. Note that spoken name confirmation is available when a recorded name exists 
for the VPIM subscriber. See the “VPIM Subscribers” section on page 7-27 for more information.

Messaging Similarities and Limitations

For the most part, messaging between Cisco Unity subscribers and individuals on a VPIM-compliant 
voice messaging system is the same as messaging among Cisco Unity subscribers. For example:

• Messages marked urgent when they are sent are marked urgent when they are retrieved by the 
recipient.

• Messages marked private when they are sent are marked private when they are retrieved by the 
recipient.

• Subscribers can send messages to Cisco Unity distribution lists that include VPIM subscribers.

• Subscribers can send fax messages, if this is supported by the remote voice messaging system.
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Note the following exceptions:

• E-mail messages sent to VPIM recipients are returned to the sender as NDRs.

• Messages sent to Cisco Unity distribution lists from subscribers on the remote voice messaging 
system are not delivered, and an NDR is returned to the sender. Incoming VPIM messages to 
Cisco Unity are delivered to subscriber mailboxes only, and cannot be delivered to public 
distribution lists. Additionally, incoming messages must be addressed to the primary extension of 
the subscriber; messages addressed to an alternate extension will not be delivered.

VPIM Networking and Blind Addressing
Blind addressing is one of the methods that Cisco Unity provides for addressing VPIM messages to users 
of another voice messaging system. Blind addressing allows Cisco Unity to address messages without 
having specific information about the recipients on the remote voice messaging system (such as their 
names and mailbox numbers). One of the steps to setting up blind addressing is to change the Blind 
Addressing setting on the Primary Location > Addressing Options page to something other than None. 
You also create a VPIM delivery location that corresponds to each voice messaging system with which 
Cisco Unity communicates.

You provide the following key information for each delivery location:

• Dial ID—A unique number that identifies the location to Cisco Unity. This is the number that 
subscribers dial when blind addressing messages to individuals who use the remote voice messaging 
system.

• SMTP Domain Name—The Internet-addressable SMTP domain name that is used to construct 
addresses for individuals who use the voice messaging system that corresponds to the delivery 
location.

When blind addressing a message, subscribers dial a number that is made up of the delivery location Dial 
ID and the mailbox number of the recipient. Before addressing the message, Cisco Unity parses the 
number that the subscriber enters and searches for a matching delivery location. If Cisco Unity does not 
find a matching location, it reports the error to the sender and does not address the message. If a matching 
delivery location is found, Cisco Unity addresses the message without verifying that the remote mailbox 
number exists. Cisco Unity does provide voice name confirmation that the delivery location exists before 
addressing the message (assuming that a voice name was recorded for the delivery location).

Subscriber Experience with Blind Addressing

Subscribers can address messages by using the phone or the DUC-enabled Notes client. To address a 
message by using Notes, subscribers enter the address in the following format:

VPIM:<Delivery Location Dial ID>_<Remote Mailbox Number>@<ForeignDomain>

Because your Cisco Unity server does not have access to the names, extensions, and recorded voice 
names of the people who use the other voice messaging system, subscribers will encounter some 
limitations with blind addressing:

• When addressing a message, the sender does not hear voice name confirmation. Cisco Unity cannot 
verify that the entered number is correct, so subscribers may inadvertently address a message to the 
wrong person or to a non-existent extension. However, subscribers will receive an NDR if the 
number turns out to be an invalid extension.

• When addressing a message, subscribers cannot use spelled-name mode; subscribers address the 
message only by using number mode, so they must know the delivery location Dial ID and the 
mailbox number for the recipient.
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• Blind addresses cannot be added to public distribution lists.

• When subscribers use the phone to listen to messages from someone at the VPIM location, the 
conversation (also known as the telephone user interface, or TUI) cannot identify the sender.

• When subscribers use the DUC-enabled Notes client to listen to messages from someone at the 
VPIM location, the From address is in the format VPIM:<Delivery Location Dial ID>_<Remote 
Mailbox Number>@<Foreign Domain>. Note that the sender can be identified only if the remote 
system included the recorded voice name of the sender in the message.

In Cisco Unity 4.0(5) and later, subscribers can use the Cisco Unity conversation to add and delete blind 
addresses in their private distribution lists. In contrast, subscribers cannot use the Cisco Unity Assistant 
to add blind addresses to their private lists, though they can use it to view list members and to delete any 
blind addresses that were added by phone. The Cisco Unity Administrator also does not allow you to add 
blind addresses to private lists, but you can use it to view and delete list members.

VPIM Subscribers
VPIM subscribers are a representation in Cisco Unity of individuals who use another voice messaging 
system. VPIM subscribers are created in Cisco Unity to enable Cisco Unity subscribers to find them in 
the directory and to send them messages as they would with any other subscriber. Voice messages 
addressed to VPIM subscribers are sent to the voice messaging system that they use.

VPIM subscribers do not require additional Domino client access licenses (CALs), and they do not 
consume Cisco Unity subscriber licenses. The Cisco Unity subscriber license count does not change 
when you create VPIM subscribers.

To set up VPIM subscribers, you first create a VPIM delivery location that corresponds to each remote 
voice messaging system with which Cisco Unity communicates. After creating the delivery locations, 
you create a VPIM subscriber for each remote user. When creating each VPIM subscriber, you specify 
the user mailbox number on the other voice messaging system, and select a VPIM delivery location with 
which to associate the subscriber. The Interop Gateway uses the information on the associated delivery 
location when delivering a message to the VPIM subscriber. Note that VPIM subscribers can be created 
only on the VPIM bridgehead server on which the associated VPIM delivery location has been created.

You create and manage VPIM subscriber accounts in much the same way that you do regular subscriber 
accounts. You can use the Cisco Unity Administrator to create, modify, and delete VPIM subscriber 
accounts one at a time, and you can use the Cisco Unity Bulk Import wizard to create and modify 
multiple VPIM subscriber accounts.

Extensions are mandatory for VPIM subscribers. The extension is the number that subscribers dial when 
addressing a message to a VPIM subscriber. This number may or may not be the same as the mailbox 
number of the VPIM subscriber on the remote voice messaging system. Callers who reach the opening 
greeting of your organization can dial the extension of a VPIM subscriber or look up a VPIM subscriber 
in directory assistance and leave a message.

VPIM subscribers have corresponding Domino Person documents that have “Other Internet Mail” set in 
the Mail System field, and they are listed in the Notes address book. When you delete VPIM subscribers, 
the associated Person documents are deleted automatically.

Other than receiving messages, VPIM subscribers do not have access to other Cisco Unity features, and 
some sections of the Cisco Unity Administrator are disabled for VPIM subscribers. VPIM subscribers:

• Cannot log on to Cisco Unity by phone to check or send messages.

• Cannot log on to Cisco Unity by phone—or use the Cisco Unity Assistant—to adjust personal 
settings, so their recorded names and greetings can only be recorded or changed in the Cisco Unity 
Administrator.
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• Cannot own private lists.

• Cannot set up or receive message notifications.

• Cannot receive message waiting indications.

Manually setting up VPIM subscribers requires more overhead for administrators of Cisco Unity than 
blind addressing does. However, the VPIM subscriber option allows other subscribers to address 
messages to VPIM subscribers the same way that they address messages to regular subscribers.

In general, creating VPIM subscriber accounts is a good solution in the following circumstances:

• When there are only a few subscribers at the other voice messaging system who need to receive 
messages from the subscribers at your location. (Note however that there are no technical constraints 
associated with creating large numbers of VPIM subscribers.)

• When unidentified callers need to be able to call the local Cisco Unity server to leave a message for 
someone on the other voice messaging system. This may provide a way for local callers to avoid 
long distance charges when leaving a message for a remote VPIM subscriber.

• When the functionality described in the following section, “Subscriber Experience with VPIM 
Subscribers,” is required.

Because of the administrative overhead of setting up and maintaining many VPIM subscriber accounts, 
you may prefer a combination of blind addressing and VPIM subscribers. For example, you might want 
to set up VPIM subscriber accounts for senior sales staff, but not for other employees.

Subscriber Experience with VPIM Subscribers

Provided that VPIM subscribers are listed in the phone directory and have had voice names and greetings 
recorded for them:

• Subscribers can address messages to VPIM subscribers by using the phone, or the DUC-enabled 
Notes client.

• VPIM subscribers are listed in the Notes address book.

• When using the phone, subscribers can address messages to VPIM subscribers in spelled-name 
mode (if enabled on the system) or by extension.

• Subscribers hear voice name confirmation when addressing a message to a VPIM subscriber.

• When subscribers use the phone to listen to messages, the conversation announces who the message 
is from.

• VPIM subscribers can be added to private and public distribution lists.

When Cisco Unity records a message from an unidentified caller for a VPIM subscriber, 
“non-mail-user@<Domain Name>” is used as the sender of the message, as required by the VPIM 
specification. Although VPIM subscribers are not prevented from replying to these messages, the reply 
messages are returned to the Unity Messaging System mailbox as NDRs.

Identified Subscriber Messaging
Identified subscriber messaging (ISM) affects what subscribers hear when they call other subscribers 
from their primary or alternate extensions and are forwarded to the greetings of the subscribers they call. 
If they then leave a message, ISM affects what the called subscriber hears and can do when listening to 
the message. When ISM is enabled, Cisco Unity recognizes that the calling extension is associated with 
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a subscriber and accordingly plays the internal greeting of the called subscriber. Additionally, when the 
called subscriber later listens to the message, Cisco Unity plays the recorded voice name of the 
subscriber who left the message and allows the called subscriber to record a reply.

When a call to a Cisco Unity subscriber is forwarded to the subscriber greeting and ISM is enabled, 
Cisco Unity compares the calling number (ANI or caller ID) to the primary and alternate extensions of 
subscribers. If a match is found, Cisco Unity identifies the caller as a subscriber. When Cisco Unity 
compares the calling number to extensions, by default, only “regular” Cisco Unity subscribers on the 
local system are included in the comparison. Beginning with Cisco Unity 4.0(3), ISM can be expanded 
to include all Cisco Unity subscribers throughout a dialing domain.

You can enable ISM for AMIS, Bridge, and VPIM subscribers (collectively referred to as external 
subscribers), so that Cisco Unity will include them when comparing calling numbers to extensions. Note 
the following:

• After enabling ISM for external subscribers, Cisco Unity must be restarted.

• If multiple Cisco Unity servers are networked via Digital Networking, ISM functionality can be 
made available only on the Cisco Unity servers that are in the same dialing domain as the bridgehead 
server.

• You must enable ISM for external subscribers for each Cisco Unity server on which the functionality 
is desired.

• If a single Cisco Unity server is in use, the Cisco Unity server must be a member of a dialing domain 
for this functionality to be used.

Note the difference between leaving a messaging and sending a message. When a person on the remote 
voice messaging system with a corresponding external subscriber account records and sends a message 
to a Cisco Unity subscriber (as opposed to calling and leaving a message), all versions of Cisco Unity 
identify the message as being from the corresponding external subscriber.

The phone system provides the calling number to Cisco Unity. The number of digits included in the 
calling number is configurable in most phone systems. For Cisco Unity to find a matching subscriber 
extension, the phone system must be configured to provide the applicable number of digits in the calling 
number. You may also need to add alternate extensions to the subscriber accounts to match the calling 
number. Additionally, there may be other phone system-specific issues that prevent Cisco Unity from 
matching the calling number to a subscriber extension. Refer to your phone system documentation and 
the applicable Cisco Unity integration guide for details about the call information provided by the phone 
system.

Live Reply to VPIM Subscribers
Live reply allows subscribers who listen to their messages by phone to respond to messages from other 
subscribers by calling them. When live reply is enabled, subscribers listening to messages by phone can 
reply to a subscriber message by pressing 4-4 to have Cisco Unity call the subscriber directly. 
(Subscribers using Optional Conversation 1 press 8-8 for live reply.) Note that whether subscribers have 
access to the live reply feature depends on their class of service settings. (Live reply is enabled on the 
Subscribers > Class of Service > Messages page in the Cisco Unity Administrator.)

Subscribers can live reply to messages from subscribers on other voice messaging systems who have 
corresponding VPIM subscriber accounts in Cisco Unity. In order for the live reply call to be 
successfully transferred, a call transfer number must be configured for the VPIM subscribers.
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Note that a live reply to a VPIM subscriber is always done via a release to phone system transfer, even 
when both the Cisco Unity subscriber who is replying to a message and the VPIM subscriber have 
accounts on the same Cisco Unity server. On a release to switch transfer, Cisco Unity dials the call 
transfer number configured for the VPIM subscriber and hangs up, leaving the phone system to handle 
the call. Note the following limitations with release to switch transfers:

• The VPIM subscriber call screening, call holding, and announce features are ignored.

• The call transfer setting “No (Send Directly to Subscriber's Greeting)” is ignored. Cisco Unity dials 
the VPIM subscriber extension and hangs up. If the subscriber extension is a valid extension on the 
phone system that Cisco Unity is integrated with, then the subscriber phone rings. If the subscriber 
extension is not a valid phone extension, what happens to the call after that depends on the phone 
system and how it is configured. If you do not configure the phone system to handle calls to the 
subscriber extensions, the caller may be disconnected.

Note the following:

• Live reply to VPIM subscribers is enabled automatically, and cannot be disabled.

• Live replies to VPIM subscribers with accounts on other Cisco Unity servers do not use the 
cross-server live reply functionality that can be used to live reply to Cisco Unity subscribers with 
accounts on other Cisco Unity servers. However, for live reply to be offered when a Cisco Unity 
subscriber replies to a message from a VPIM subscriber with a subscriber account on another 
Cisco Unity server, the servers must be in the same dialing domain.

Deleting VPIM Subscribers
Each VPIM subscriber is associated with a Domino Person document. When you delete VPIM 
subscribers in the Cisco Unity Administrator by deleting the subscriber accounts individually, the 
underlying Person documents are automatically deleted. To delete all of the VPIM subscribers associated 
with a delivery location, the underlying Person documents associated with the subscribers, and the 
delivery location itself, use the Global Subscriber Manager, available in Tools Depot. Note that when 
you delete an AMIS delivery location, blind addressees are also removed from all private lists. Consider 
notifying subscribers of these potential changes to their private lists.

Extension Addresses
When you create a VPIM subscriber, Cisco Unity adds to the Forwarding Address field of the associated 
Person document an address in the following format:

VPIM:<Delivery Location Dial ID>_<Remote Mailbox Number>@<ForeignDomain>

This special e-mail address is called an extension address or a remote address. The extension address is 
a combination of the delivery location Dial ID with which the VPIM subscriber is associated, the Remote 
Mailbox Number of the VPIM subscriber, and the Interop Gateway foreign domain name.

When subscribers use the phone to address messages to a VPIM subscriber, they dial an extension. 
Cisco Unity recognizes the recipient as a VPIM subscriber and retrieves the extension address from the 
SQL database on the Cisco Unity server.

Extension addresses are generated automatically when you create VPIM subscribers. Extension 
addresses are updated automatically when you change the remote mailbox number and the Dial ID of a 
delivery location. Extension address are not automatically updated when the foreign domain name is 
changed. For more information, see the “Changing the Interop Gateway Foreign Domain Name” section 
on page 7-39.
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Preventing Subscribers From Adding Individual Subscribers to Private Lists in 
the Cisco Unity Assistant

In the transition from a legacy voice messaging system to Cisco Unity, your organization may choose to 
migrate users to Cisco Unity in phases. As a result, Cisco Unity will likely support both regular 
subscribers and “external” subscribers—Bridge, AMIS, or VPIM contacts (as applicable)—at the same 
time. Regular subscribers can send messages to external subscribers, and even add them to their private 
distribution lists during the transition.

However, once external subscribers are converted into regular Cisco Unity subscribers, they are 
automatically removed from all private lists without notifying private list owners. When this occurs, 
subscribers may continue to send messages to their private lists without realizing that some of their 
intended recipients no longer receive them.

When convenient and practical, Cisco Unity administrators should notify subscribers when external 
subscribers are converted to regular subscribers, notifying subscribers that they should re-add the newly 
migrated subscribers to existing private lists, as applicable. During the migration phase, you may also 
want to consider preventing subscribers from adding subscribers to their private lists in the Cisco Unity 
Assistant, and asking them not to use the Cisco Unity phone menus to do so—at least until the migration 
process is complete.

Use the following procedure to prevent all subscribers associated with the Cisco Unity server from 
adding individual subscribers to their private lists in the Cisco Unity Assistant. The procedure does not 
prevent subscribers from using the Cisco Unity phone menus to add regular and external subscribers to 
their private lists, nor does it prevent subscribers from addressing messages to regular and external 
subscribers.

To Prevent Subscribers From Adding Individual Subscribers to Private Lists in the Cisco Unity Assistant

Step 1 On the Cisco Unity server desktop, double-click the Cisco Unity Tools Depot icon.

Step 2 In the left pane, under Administrative Tools, double-click Advanced Settings Tool.

Step 3 In the Unity Settings pane, click Unity Assistant—Do Not Allow Subscribers to Add Subscribers to 
Private Lists.

Step 4 In the New Value list, click 1, and then click Set so that when subscribers add members to their lists in 
the Cisco Unity Assistant, the Find Names dialog box does not display the Subscribers tab. (Subscribers 
can continue to add distribution lists to their lists from the Distribution Lists tab.)

Step 5 When prompted, click OK.

Step 6 Click Exit.

You do not need to restart Cisco Unity to enable the change.

Migrating Subscribers from Another Voice Messaging System to Cisco Unity
If you are using VPIM to migrate from another voice messaging system to Cisco Unity, there are several 
tools that you can use to create Cisco Unity subscribers from VPIM subscriber information. See the 
following sections for more information:

• Migrating Subscribers in Bulk, page 7-32

• Private List Considerations for Migrating Subscribers, page 7-32
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Migrating Subscribers in Bulk

Following are the general steps for migrating VPIM subscribers to Cisco Unity subscribers, in bulk. 
Refer to the Help files of the applicable tools for more detailed information. (Click the Tools Depot icon 
on the Cisco Unity server, and click the applicable tool in the left pane to view the Help file.)

1. As a best practice, back up the Cisco Unity server (just as a precaution, because you will be deleting 
data).

2. Run Subscriber Information Dump from Tools Depot, and output the VPIM subscriber information 
to a CSV file.

3. Modify the CSV file as needed so that you can use it as the input file when you use the Cisco Unity 
Bulk Import wizard to create Cisco Unity subscribers.

4. Run Global Subscriber Manager from Tools Depot to delete the VPIM delivery locations and the 
associated VPIM subscribers and underlying Person documents.

5. If the people migrating from the remote voice messaging system have not been Notes mail users, 
register the people in Domino.

6. Run the Cisco Unity Bulk Import wizard by using the input file that you prepared in step 3.

Private List Considerations for Migrating Subscribers

When you migrate VPIM subscribers, consider notifying Cisco Unity subscribers of these potential 
effects on private distribution list membership:

• When you delete a delivery location, blind addressees are removed from all private lists.

• When a VPIM subscriber becomes a regular subscriber, the VPIM subscriber is removed from all 
private lists.

Considerations for Digitally Networked Cisco Unity Servers
A small subset of subscriber and distribution list data is stored in the Domino Directory, as is most 
location data. In organizations with multiple Cisco Unity servers networked together such that they 
access a common directory, the Cisco Unity-specific data replicates to all Cisco Unity servers in the 
network. Therefore, all Cisco Unity servers on the network have the information that subscribers need 
to address messages to users at a VPIM location.

Because of directory replication, VPIM delivery locations and VPIM subscribers need to be created only 
on one Cisco Unity server in the network. If allowed by the primary location addressing options on each 
server, all subscribers, no matter which Cisco Unity server they are associated with, can send messages 
to a VPIM delivery location or to a VPIM subscriber created on another server. The Cisco Unity server 
configured for VPIM acts as the VPIM “bridgehead” server for the other Cisco Unity servers in the 
network.
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Phone Prefixes
Each VPIM delivery location provides the following prefixes, which are used to accommodate various 
numbering plans:

• Remote Phone Prefix—This number is used to construct addresses for users at a VPIM location. On 
outgoing messages to the VPIM location, the Interop Gateway adds the prefix to the beginning of 
the recipient mailbox number to form the To address. On incoming messages from the VPIM 
location, the Interop Gateway removes the prefix from the beginning of the sender mailbox number 
to form the From address.

• Cisco Unity Phone Prefix—This number is used to construct addresses for Cisco Unity subscribers. 
On outgoing messages to the VPIM location, the Interop Gateway adds the prefix to the beginning 
of the sender mailbox number to form the From address. On incoming messages from the VPIM 
location, the Interop Gateway removes the prefix from the beginning of the recipient mailbox 
number to form the To address.

If all VPIM delivery locations have a unique domain name, prefixes are optional. If you have multiple 
delivery locations with the same domain name, the Remote Phone Prefix is required. Within the set of 
delivery locations with the same domain name, the Remote Phone Prefix must be a unique number.

For example, assume that an organization has implemented a 10-digit numbering plan, in which the 
mailbox numbers for Cisco Unity subscribers begin with 206, and the mailbox numbers of subscribers 
on a VPIM voice messaging system begin with 425.

Assume the following has been set on the VPIM delivery location:

• Dial ID = 425

• Remote Phone Prefix = 425

By setting both the Remote Phone Prefix and the Dial ID to 425, the number that a subscriber enters 
when blind addressing a message to someone at the VPIM location is the same number that the 
subscriber enters when calling the person.

Because of the prefix, VPIM subscribers are assigned a 7-digit Remote Mailbox Number. In this 
example, for outgoing messages the Interop Gateway would add the prefix 425 to the beginning of the 
remote mailbox number, creating a 10-digit recipient mailbox number.

Audio Format Considerations
The Audio Format Conversion settings on the VPIM delivery location page in the Cisco Unity 
Administrator allow you to control the audio format of outgoing and incoming VPIM messages, as 
follows:

• Outbound Messages—You can set whether outbound VPIM messages are converted to G.726 or sent 
in the format in which they were recorded (no audio format conversion).

• Incoming Messages—You can set whether incoming VPIM messages are converted to G.711 
(mu-law), GSM 6.10, G.729a, or stored in the format in which they were sent (no audio format 
conversion).

To make decisions about these settings, consider the following:

• The audio format that the local Cisco Unity server (or servers, if there are multiple Cisco Unity 
servers networked together) uses for recording and playing voice messages.
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• The audio format in which the remote voice messaging system can send and receive VPIM 
messages. Some voice messaging systems support only the G.726 format for VPIM messages, but 
you will need to consult the documentation of the remote voice messaging server to be sure.

• Network bandwidth.

We recommend that incoming VPIM messages be stored in the same audio format that the local 
Cisco Unity server(s) use for recording and playing messages. However, if you want incoming VPIM 
messages to be stored in some other audio format, you will need to verify that the applicable codec is 
installed on all Cisco Unity servers and on other computers that access these messages. In particular:

• If your organization has multiple Cisco Unity servers networked together, all of the Cisco Unity 
servers must have the codec installed.

• If subscribers use the DUC-enabled Notes client to listen to messages, the codec may need to be 
installed on each subscriber workstation.

Related Documentation

• For additional details about the Audio Format Conversion settings, see the “VPIM Delivery 
Location Profile Settings” section on page 7-34.

• For general information about audio formats supported by Cisco Unity, see the White Paper: Audio 
Codecs and Cisco Unity (All Versions), at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/products_white_paper09186a00800875
b7.shtml.

• For information specific to messaging between Cisco Unity servers in different directories, see the 
“Audio Format Conversion Settings” section on page 8-3.

VPIM Reference
This section contains tables that define the fields on the Cisco Unity Administrator web pages related to 
VPIM setup, and briefly explain the options for correctly entering information in the fields.

VPIM Delivery Location Profile Settings
VPIM delivery locations are Cisco Unity objects that contain the addressing information that 
Cisco Unity needs to send messages to and receive messages from another voice messaging system. You 
create a VPIM delivery location that corresponds to each remote voice messaging system with which 
Cisco Unity communicates.

Use the following tables to learn more about the delivery location profile settings for a VPIM location.

Table 7-1 Profile Settings Applicable to All Types of Delivery Locations

Field Considerations

Name This displays the name of the delivery location. To change the name, enter a new name here, 
and then click the Save icon.
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Dial ID Enter the ID that identifies the location to Cisco Unity. Enter numbers only, up to a 
maximum of ten digits. The default minimum length is three digits.

Although the minimum length for Dial IDs can be reduced by using the Advanced Settings 
Tool, one- and two-digit Dial IDs may conflict with private distribution list IDs during an 
address search. When a subscriber addresses a message by entering a one- or two-digit 
number, Cisco Unity first searches for a matching private distribution list. If a match is 
found, the search stops. Therefore, when a subscriber addresses a message by entering a 
location Dial ID (to narrow down the search scope to a particular location), if the number 
entered matches a private distribution list ID, the conversation offers only the private 
distribution list as a destination. If subscribers do not address messages to other locations by 
first entering a Dial ID, there is no conflict, and the minimum length for Dial IDs can be 
reduced to accommodate complex dial plans.

When sending messages to a remote location, subscribers can dial a number that is made up 
of the Dial ID and the Remote mailbox number of the recipient.

The following policies are recommended:

• Establish a fixed length for Dial IDs and if possible, a fixed length for extensions.

• Assign unique Dial IDs. Dial IDs should not be the same as other Dial IDs or extensions.

• Assign Dial IDs that have at least three-digits.

• Use a different numbering range for Dial IDs than for extensions.

• If you use variable-length Dial IDs, the first digits of each ID should be unique with 
respect to other Dial IDs.

• Even if the Dial ID will never be used by subscribers when they address messages, enter 
a number that does not conflict with extensions, such as 001 or 002.

Recorded Name Record a name for the delivery location. The subscriber conversation plays this recorded 
name in a number of places. For example, assume that the setting Include Locations in 
Searches on the Network > Primary Location > Addressing Options page is enabled. When 
subscribers address a message by spelling the name, the recorded name for this delivery 
location is played in the message addressing search results along with subscriber names. (For 
example: “There are two matches. For Chris Newton, press 1. For New York, press 2.”)

To record the name here, use the Media Master control bar. (Note that the Media Master is 
not available across a firewall that blocks DCOM communications.) Use the Options menu 
in the Media Master control bar to set recording and playback devices, if applicable, and to 
use other sound files.

Table 7-1 Profile Settings Applicable to All Types of Delivery Locations (continued)

Field Considerations
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Destination Type Display only. Indicates the type of delivery location. The Destination Type is specified when 
the delivery location is created, and it cannot be changed. The Destination Type is one of the 
following:

• AMIS—Indicates that the delivery location corresponds to an AMIS-compliant voice 
messaging system. Messages are sent by using the industry-standard Audio Messaging 
Interchange Specification analog (AMIS-a) protocol.

• Bridge—Indicates that the delivery location corresponds to an Octel node in an Octel 
analog network. Messages are exchanged between Cisco Unity and the Octel system by 
using the Cisco Unity Bridge. Cisco Unity sends messages to the Bridge in Voice Profile 
for Internet Mail (VPIM) format with proprietary extensions. The Bridge converts the 
message format and sends it to the appropriate Octel server by using the Octel Analog 
Networking protocol.

• VPIM—Indicates that the delivery location corresponds to a VPIM-compliant voice 
messaging system. Messages are sent by using the industry-standard VPIM protocol 
over the Internet or a private TCP/IP network.

Table 7-2 Profile Settings Specific to VPIM Delivery Locations

Field Considerations

SMTP Domain Name Enter the Internet-addressable SMTP domain name that is used to construct addresses for 
individuals who use the voice messaging system that corresponds to this delivery location. This is 
the right half of an e-mail address after the @ symbol (for example, london.cisco.com). Do not enter 
the @ symbol; Cisco Unity automatically inserts it.

The Interop Gateway accepts VPIM messages only from addresses with a domain name that 
corresponds to an SMTP Domain Name in a VPIM Delivery Location. Therefore, the domain name 
entered here must exactly match the domain name that the remote voice messaging system uses 
when sending messages to Cisco Unity.

Remote Phone Prefix Enter the number that is used to construct addresses for individual who use the voice messaging 
system that corresponds to this delivery location. The maximum allowable digits in the prefix is 64.

Subscribers do not enter the prefix when addressing messages. On outgoing messages from 
Cisco Unity to the remote system, the Interop Gateway adds the prefix to the beginning of the 
recipient mailbox number to form the To address.

On incoming messages to Cisco Unity from the remote system, the Interop Gateway removes the 
prefix from the beginning of the sender mailbox number to form the From address.

If all delivery locations have a unique domain name, this field is optional. This field is required to 
be a unique number if you have multiple delivery locations with the same domain name.

Table 7-1 Profile Settings Applicable to All Types of Delivery Locations (continued)

Field Considerations
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Unity Phone Prefix Enter the number that is used to construct addresses for Cisco Unity subscribers who send messages 
to individuals who use the voice messaging system that corresponds to this delivery location. The 
maximum allowable digits in the prefix is 64.

On outgoing messages from Cisco Unity subscribes to subscribers at this VPIM location, the 
Interop Gateway adds the prefix to the beginning of the sender mailbox number to form the From 
address.

On incoming messages to Cisco Unity subscribers from subscribers at this VPIM location, the 
Interop Gateway removes the prefix from the beginning of the recipient mailbox number to form 
the To address.

Audio Format 
Conversion: Incoming 
Messages

Indicate whether incoming messages from the remote system that corresponds to this VPIM 
location should be converted to another audio format. Messages and voice names (if included) from 
the remote system will be stored in the selected audio format. Choose from the following:

• Do Not Convert Incoming Messages—Incoming messages are not converted to another audio 
format. Choose this option if you want the messages to be stored in the same format in which 
they were sent. Typically, you only choose this option when the remote system is another 
Cisco Unity server, which can send message in formats other than G.726. For other voice 
messaging systems, consult the documentation to determine the audio formats that the system 
supports for VPIM messages.

• G.711 (mu-law)—Incoming messages are converted to G.711 format. This audio format is fully 
supported by Cisco Unity and Cisco CallManager, and the codec is installed automatically by 
Windows.

• GSM 6.10—Incoming messages are converted to GSM 6.10 format. This audio format is fully 
supported by Cisco Unity and Cisco CallManager, and the codec is installed automatically by 
Windows.

• G.729a—Incoming messages are converted to G.729a format. This audio format is fully 
supported by Cisco Unity and Cisco CallManager, and the codec is installed automatically by 
Cisco Unity.

We recommend that incoming VPIM messages be stored in the same audio format that the local 
Cisco Unity server(s) use for recording and playing messages. However, if you want incoming 
VPIM messages to be stored in some other audio format, you will need to verify that the applicable 
codec is installed on all Cisco Unity servers, and other computers that access these messages. In 
particular:

• If your organization has multiple Cisco Unity servers networked together, all of the 
Cisco Unity servers must have the codec installed.

• If subscribers use the DUC-enabled Notes client to listen to messages, the codec may need to 
be installed on each subscriber workstation.

Table 7-2 Profile Settings Specific to VPIM Delivery Locations (continued)

Field Considerations
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Maintenance
This section provides information on various tasks that you may need to maintain your VPIM 
Networking configuration. See the following sections for details:

• Changing the Interop Gateway Foreign Domain Name, page 7-39

• Moving the Interop Gateway Mail File, page 7-41

Audio Format 
Conversion: Outbound 
Messages

Indicate whether outbound messages from Cisco Unity to the remote system that corresponds to 
this VPIM location should be converted to another audio format. Messages and voice names (if 
included) will be sent in the selected audio format. Choose from the following:

• Do Not Convert Outgoing Messages—Outbound messages are not converted to another audio 
format. Choose this option if you want the messages to be sent in the same format in which 
they were recorded. Typically, you only choose this option when the remote system is another 
Cisco Unity server. For other voice messaging systems, consult the documentation to 
determine the audio formats that the system supports for VPIM messages.

• G.726—Outbound messages are converted to G.726 format. This is the format required by the 
VPIM Version 2 specification and supported by all VPIM-compliant voice messaging systems.

When Sending 
Messages from 
Cisco Unity Include the 
Sender’s Recorded 
Name

Check this check box to have the voice name of the sending Cisco Unity subscriber added to the 
beginning of each message sent to this VPIM location.

Some legacy systems can create directory entries using the recorded name and vCard of the sender. 
If the remote system is Cisco Unity with Microsoft Exchange, the recorded name and vCard may 
be used to create or update directory entries. If the remote system does not have directory entries 
that correspond to local Cisco Unity subscribers, you may want to send the recorded voice name so 
that the sender is identified when recipients listen to messages.

When Sending 
Messages from 
Cisco Unity Include the 
Sender’s vCard

Check this check box to have the Interop Gateway attach a vCard that contains information about 
the sending Cisco Unity subscriber to each outgoing message to this VPIM location. The vCard will 
contain the following information about the sender:

• Name

• Phone Number

• E-mail Address

Some legacy systems can create directory entries by using the recorded name and vCard of the 
sender. If the remote system is Cisco Unity with Microsoft Exchange, the data may be used for 
creating or updating directory entries, if the remote system is configured to allow automatic 
creation, updates, and deletion of VPIM subscribers for the delivery location corresponding to this 
system.

Table 7-2 Profile Settings Specific to VPIM Delivery Locations (continued)

Field Considerations
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Changing the Interop Gateway Foreign Domain Name
The following task list provides an overview of how to change the name of the Foreign domain used by 
the Interop Gateway. We recommend that you change the Foreign domain name after normal business 
hours when message traffic is light, because messages to VPIM recipients may be sent back as 
undeliverable until the Foreign domain name has been changed in every place that it is stored.

1. On the Cisco Unity server on which the Interop Gateway service—CsDomInteropGty—is running, 
rerun the Interop Gateway Configuration wizard and change the Foreign domain name. This updates 
settings stored in SQL and in the registry. (The settings in SQL will replicate to all other Cisco Unity 
servers in your installation, but the registry change must be made on each Cisco Unity server, as 
described in the next step.)

2. On the Cisco Unity VPIM bridgehead server (which may or may not be the same server on which 
the Interop Gateway service is running), enter the new Foreign domain name in the SMTP Domain 
Name field on the Primary Location Profile page.

3. If your installation consists of multiple Cisco Unity servers (either Digitally Networked servers 
and/or secondary failover servers), you must change the Foreign domain name stored in the registry. 
Open the Advanced Settings Tool in Tools Depot to change the Foreign Domain name in the setting 
Networking – Change Interop Gateway Foreign Domain Name (Domino Only).

4. Restart Cisco Unity.

5. In Domino Designer, copy the agent from the 
CommServer\Utilities\Domino\Agents\UpdateRemoteSubscribers directory of a Cisco Unity 
server, and paste it in names.nsf on a “hub” Domino server that pushes out directory changes.

6. In the Domino Administrator, run the agent to change the Foreign domain name in the Forwarding 
Address field of each Person document that corresponds to an AMIS, Bridge, or VPIM subscriber.

The following procedure provides detailed steps.

To Change the Interop Gateway Foreign Domain Name

Step 1 On the Cisco Unity server on which the Interop Gateway service—CsDomInteropGty—is running, 
browse to the directory in which Cisco Unity is installed (the default location is C:\CommServer).

Step 2 Double-click UnityDominoInterOpSetup.exe to run the Interop Gateway Configuration wizard.

Step 3 On the Welcome screen, click Next.

Step 4 On the Configure the Interop Gateway screen, click either Use a New Foreign Domain or Use an 
Existing Foreign Domain.

• If you choose to use a new Foreign domain, in the text box, enter the domain name that will be used 
to route VPIM messages to the Interop Gateway mail file. The Interop Gateway Configuration 
wizard creates a new Foreign domain document with the specified name.

• If you choose to use an existing Foreign domain, click the Foreign domain name on the list.

Step 5 Click Next to go to the Foreign Domain Mail Information screen. If you chose to use an existing Foreign 
domain, the mail file name and the Domino server on which the mail file resides are displayed. Verify 
the information, and skip to Step 6.

If you chose to create a new Foreign domain:

a. Click the down button for the Domino Server list and wait for the list to be populated with all of the 
Domino server names in your network. Choose the server on which the Interop Gateway mail file 
will be created. Although you can type in the server name, you must enter the server name by using 
the hierarchical naming format (for example “ServerName/Org”).
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b. In the Mail File Name field, enter the name of the mail file to be monitored by the Interop Gateway 
(for example, interop.nsf). The Interop Gateway Configuration wizard will create the mail file, so 
enter a file name that does not already exist.

Step 6 Click Next. Choose the Windows account that the Interop Gateway service will log on with. We 
recommend that you choose Local System. However, if you choose an existing Windows account, you 
will need to ensure that it has the same level of permissions as were set by the Permissions wizard during 
Cisco Unity setup for the directory and messaging services account.

Step 7 Click Next and review the summary information to verify that it is correct.

Step 8 Click Finish and the wizard configures and starts the Interop Gateway service on the Cisco Unity server. 
When the wizard finishes, a message box displays to let you know whether the configuration was 
successful.

Step 9 In the Cisco Unity Administrator, go to the Network > Primary Location > Profile page.

Step 10 Enter the new Foreign domain name in the SMTP Domain Name field.

Step 11 Click the Save icon.

Step 12 If your installation consists of only one Cisco Unity server, skip to Step 26.

Otherwise, log on to another Cisco Unity server (either a Digitally Networked server or a secondary 
failover server), and on the Cisco Unity server desktop, double-click the Cisco Unity Tools Depot icon.

Step 13 In the left pane of the Tools Depot window, expand Administration Tools, and double click Advanced 
Settings Tool.

Step 14 In the Unity Settings list, click Networking – Change Interop Gateway Foreign Domain Name 
(Domino Only).

Step 15 Enter the new Foreign domain name in the New Value field, and click Set.

Step 16 Restart Cisco Unity.

Step 17 Repeat Step 12 through Step 16 on each Cisco Unity server.

Step 18 Optionally, copy the contents of the CommServer\Utilities\Domino\Agents\UpdateRemoteSubscriber 
directory on the Cisco Unity server to the Domino server where you will run Domino Designer. If you 
can browse to the Cisco Unity server from Domino Designer to open the agent, you can skip this step. 
Note that the UpdateRemoteSubscriber directory contains the files:

• Agent code to update interop foreign domain.txt

• UUIsFA.nsf

The following steps describe how to copy and run the agent UUIsFa.nsf. If you are familiar with working 
with Domino agents, you may prefer to create a new agent by using the code in the .txt file instead. Also 
note that the following steps are specific to Domino R6.5. Adjust them as needed for other Domino 
versions. Refer to your Domino documentation for additional information.

Step 19 Open Domino Designer, and click Open an Existing Database.

Step 20 Browse to UUIsFA.nsf, and click Open.

Step 21 Click View > Go To > Agents.

Step 22 In the right pane, right-click the agent, and click Copy.

Step 23 Click File > Database > Open, and open names.nsf on a hub Domino server that pushes out directory 
changes.

Step 24 Click View > Go To > Agents.

Step 25 Click Edit > Paste to add the agent to names.nsf.
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Step 26 In the right pane, double-click Update Unity Interop Subscriber Forwarding Address to open the 
agent.

Step 27 Click the Save icon, close the agent dialog box, close the agent window, and exit Domino Designer.

Step 28 Open the Domino Administrator, click File > Database > Open, and open names.nsf on the hub 
Domino server.

Step 29 Click Actions > Update Unity Interop Subscriber Forwarding Address to run the agent. (The agent 
may be located on the Actions > Other menu.)

Step 30 In the Old Foreign Domain dialog box, enter the old Foreign domain name and click OK.

Step 31 In the New Foreign Domain dialog box, enter the new Foreign domain name and click OK.

The agent searches the Person documents that corresponds to AMIS, Bridge, and VPIM subscribers 
looking for the old Foreign domain name in the Forwarding Address field. When it finds a match, the 
agent changes the domain name portion of the Forwarding Address field to the new Foreign domain 
name.

Moving the Interop Gateway Mail File
To move the Interop Gateway mail file to another Domino server:

1. Move the mail file.

2. Update the Foreign domain document with the new Domino server name.

3. Rerun the Interop Gateway Configuration wizard, and use the existing Foreign domain.

The following procedure provides detailed steps.

To Move the Interop Gateway Mail File

Step 1 In the Domino Administrator, click the Files tab.

Step 2 In the list in the right pane, right-click the Interop Gateway mail file, and click Move.

Step 3 In the Move Database dialog box, specify the destination Domino server, and click OK.

Step 4 Click the Configuration tab.

Step 5 In the left pane, expand Messaging > Domain.

Step 6 In the right pane, click the Foreign domain document used by the Interop Gateway, and click Edit 
Domain.

Step 7 In the Foreign domain document, click the Mail Information tab.

Step 8 In the Gateway Server Name field, enter the Domino server name where the Interop Gateway mail file 
was moved to.

Step 9 Click Save and Close.

Step 10 On the Cisco Unity server on which the Interop Gateway service is running, browse to the directory in 
which Cisco Unity is installed (the default location is C:\CommServer).

Step 11 Double-click UnityDominoInterOpSetup.exe to run the Interop Gateway Configuration wizard.

Step 12 On the Welcome screen, click Next.

Step 13 On the Configure the Interop Gateway screen, click Use an Existing Foreign Domain, and click Next.
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Step 14 On the Domain screen, confirm that the new Domino server is listed in the Domino Server field, and 
click Next.

Step 15 On the Interop Gateway Log On Properties Screen, we recommend that you click Log On as Local 
System Account.

Step 16 Click Next to review the Foreign Domain settings, and then click Finish. When the wizard finishes, a 
message box displays to let you know whether the configuration was successful.

Notable Behavior
This section describes notable behavior of VPIM Networking. See the following sections for more 
information:

• Call Transfer Settings and VPIM Subscribers, page 7-42

• Inbound Messages Are Delivered Only to Primary Extensions, page 7-43

• Inbound Search Scope, page 7-43

Call Transfer Settings and VPIM Subscribers
In installations with multiple Cisco Unity servers networked via Digital Networking, the number that 
Cisco Unity uses for call transfers to a subscriber is the only number replicated among the Cisco Unity 
servers; none of the other settings on the Subscriber > Call Transfer page in the Cisco Unity 
Administrator are replicated. For example, in Figure 7-3, call transfers are set to ring the subscriber at 
the number 9,5551212. The only call transfer setting that is replicated to other Cisco Unity servers is the 
call transfer number 9,5551212. If the setting was “Yes, ring subscriber’s extension” instead, the number 
3047 would be replicated.

Figure 7-3 Only the Call Transfer Number Is Replicated
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When the call transfer setting is set to “No (send directly to subscriber’s greeting),” the call transfer 
number is automatically set to the subscriber extension (3047 in the example above), which is replicated 
to the other networked Cisco Unity servers.

Call transfers to VPIM subscribers created on other Cisco Unity servers are always handled by the phone 
system (release to switch)—rather than by Cisco Unity (supervised transfer)—even if the subscribers are 
set up for supervised transfers (as in the above example). The release to switch call transfers happen 
when:

• A Cisco Unity subscriber chooses to call the sender (live reply) after listening to a message left by 
a VPIM subscriber. (Live replies to VPIM subscribers are always done release to switch, even when 
the reply is to a VPIM subscriber on the same Cisco Unity server.)

• A caller enters the extension of a VPIM subscriber from the automated attendant (for example from 
the opening greeting), and the VPIM subscriber account is on another Cisco Unity server.

• A caller spells the name of a VPIM subscriber from a directory handler, and the VPIM subscriber 
account is on another Cisco Unity server.

On a release to switch transfer, Cisco Unity dials the call transfer number configured for the VPIM 
subscriber and hangs up, leaving the phone system to handle the call. Note the following limitations with 
release to switch transfers:

• The VPIM subscriber call screening, call holding, and announce features are ignored.

• The call transfer setting “No (Send Directly to Subscriber's Greeting)” is ignored. Cisco Unity dials 
the VPIM subscriber extension and hangs up. If the subscriber extension is a valid extension on the 
phone system that Cisco Unity is integrated with, then the subscriber phone rings. If the subscriber 
extension is not a valid phone extension, what happens to the call after that depends on the phone 
system and how it is configured. If you do not configure the phone system to handle calls to the 
subscriber extensions, the caller may be disconnected.

Inbound Messages Are Delivered Only to Primary Extensions
When addressing a message to a Cisco Unity subscriber, users on the remote voice messaging system 
must use the primary extension of the Cisco Unity subscriber; alternate extensions are not supported. 
Senders will receive an NDR if they address a message with the alternate extension of a Cisco Unity 
subscriber.

Note also that Cisco Unity does not accept messages from a remote voice mail system that are sent to 
Cisco Unity public distribution lists, call handlers, and interview handlers. Cisco Unity accepts 
messages from a remote voice mail system only when they are sent to a subscriber primary extension.

When designing the numbering plan for Cisco Unity subscribers, as a best practice, configure the 
primary extension of all Cisco Unity subscribers with the extension that will be used for addressing from 
the remote voice mail system. Configure all other required extensions as alternate extensions, as all other 
functionality in Cisco Unity can use alternate extensions.

Inbound Search Scope
In installations with multiple Cisco Unity servers networked together, the search scope for a matching 
subscriber extension for inbound messages sent from another VPIM-compliant voice messaging system 
is set to the global directory. It is not possible to limit the inbound search scope to either a dialing domain 
or to the local Cisco Unity server.
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Chapter 7 VPIM Networking
Notable Behavior
If two (or more) Cisco Unity subscribers have identical extensions, messages from the remote voice 
messaging system will not be delivered by the Interop Gateway to any of the Cisco Unity subscribers 
with the duplicate extensions. When the Interop Gateway detects duplicate extensions, it NDRs the 
message back to the sender.
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